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Safety Information in this Manual
Notes, cautions and warnings appear throughout this book to draw your attention to important operational and
safety information.

A “NOTE” marks a short message to alert you to an important detail.

A “CAUTION?" safety alert appears with information that is important for protecting your equipment and
performance.

A “WARNING” safety alert appears with information that is important for protecting you, others and equipment
from damage. Pay very close attention to all warnings that apply to your application.

A This symbol (an exclamation point in a triangle) precedes a general CAUTION or WARNING
statement.

A This symbol (a lightning bolt in a lightning bolt in a triangle) precedes an electric shock hazard
CAUTION or WARNING safety statement.

Technical Assistance

If you encounter a problem with your EZT-430i controller, review all of your configuration information to verify
that your selections are consistent with your application: inputs; outputs; alarms; limits; etc. If the problem
persists after checking the above, you can get technical assistance by dialing 1 (513) 772-8810 or by faxing
your request to 1 (513) 772-9119, Monday thru Friday, 7:30 a.m. to 5:30 p.m. Eastern Standard Time. You
can also email your request to support@cszproducts.com.

An applications engineer will discuss your application with you.
Please have the following information available:

» Complete Model #'s and/or Serial #'s for Component(s) in Question
» Complete Software Version #'s

« All Configuration Information

* All User Manuals

Warranty and return information is on the back cover of this manual.

Your Comments

Your comments or suggestions on this manual are welcome. Please send them to:
Telephone: +1 (513) 326-5252; fax: +1 (513) 326-5258
support@cszproducts.com

EZT-430i Preface
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1 Whatis EZT-430i?

The EZT-430i system combines all of the features of a loop controller, video/chart recorder and data logging
system into a single/intuitive device. Email, SMS (text messaging), FTP (file transfer protocol for automated
data backup) and remote view/control (Web server/VNC server) are standard with EZT-430i and can be
accessed via LAN/WAN using a PC, tablet or smart phone device.

CSZ's “EZT-430i" provides a 4.3"color touch screen interface with standard “Smart Device” user interface
features for single and dual loop OEM control applications. All loop configuration and runtime user access is
configurable at the device with no PC software required. OEM'’s have the ability to configure runtime features
(screen availability, menus, language, etc...) to easily customize the system for their requirements. These
configurations can be imported/exported to any other EZT-430i single/dual loop device for setup (from
scratch) within minutes.

Individual high performance board level PID loop control boards (one for each loop) offer up to four control
outputs each, powerful profiling capabilities with up to three events and full auto tune functionality with high
resolution process inputs.

1.1 Features

Each of the EZT-430i loop control boards provide a single digital input that can be programmed as an
automatic program control input for run, hold or abort, a manual mode or failure transfer control input or a
program advance to next segment control input.

Each of the loop control boards also provide up to four control outputs which can be used as PID control
outputs for heat/cool, direct outputs for controlling external equipment related to the application through
software switches called events, or be programmed to act as system alarm outputs.

EZT-430i can be operated in single set point or automatic program control mode. Program entry is made
easy through the use of copy, paste and delete menu selections. Programs can be copied to the external
USB memory stick and then imported to another EZT-430i controller which eliminates the need to enter
duplicate programs into multiple systems.

Data file analysis tools make looking at historical data a simple task. Any control variable saved to the data
file can be plotted on the historical data chart for any time frame within the data file's total time range.

The built in Ethernet functionality includes a ‘Web Server’ to provides access to all EZT-430i data (view only),
a VNC interface for remote control and monitoring and an NTS clock, all available via a local Intranet
connection (wired or wireless), or the World Wide Web using standard software like Microsoft's Internet
Explorer.

EZT-430i provides a rich set of tools for control interaction and process monitoring. Views include single and
dual loop views, charts, alarm, automated program status as well as historical data, alarm log and audit trail
views. The menu driven interface eliminates screen “clutter” by providing an easy to use “Smart Device”
interface for interaction between the user and EZT-430i.

EZT-430i can store more than one year of data on its SD memory card. Data logging can be enabled
manually or automatically during program operation. Data backup is provided with a USB memory stick for
plug and play transfer of files to any PC running Microsoft Windows XP, Vista operating systems and via the
FTP back-up utility.

EZT-430i protects system access with 4 level security (user rights based), audit trails that document all user

activity and ensures data integrity by digitally signing all data files and audit trails to meet regulatory
requirements.

What is EZT-430i? EZT-430i REVC 11
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The EZT-430i controller includes the following features:

1.2

Single/Dual loop controller models (automatic program operation included).

Touch screen, “Smart Device” user interface (Ul).

Video recorder mode for view only applications.

Email, SMS, FTP, VNC and Web functionality standard.
Remote View/Control using PC, Tablet or Smartphone.
Detailed maintenance, alarm monitoring and alarm history.
User configurable data logging and historical data viewer.

4 level security with digitally signed audit trails and data files.
National time server connectivity with daylight savings.
Multi-lingual user interface supports over 25 languages.
30,000 hour LED display

EZT-430i REVC

What is EZT-430i?



EZT-430i User’'s Manual Cincinnati Sub-Zero

2 Installation

The following two sections will explain how to install the EZT-430i control system. EZT-430i controllers are
pre-loaded with all operating software and firmware before leaving the factory, so it is ready to install when
you receive it. Refer to Section 2 for mounting information and Section 3 for power, signal and control wiring.

Before beginning installation, read through these sections to gain an understanding of the entire installation.
Consider the installation carefully. Plan the power, signal and control wiring before installing EZT-430i. Also
consider the cabinet space, hardware dimensions and environmental conditions. Use good wiring practices
to minimize problems that may occur due to electrical interference.

e To avoid potential electric shock and other hazards, all mounting and
WARNING: wiring for EZT-430i must conform to the National Electric Code (NEC)
and other locally applicable codes.

e Special expertise is required to install, wire, configure and operate the
EZT-430i controller. Personnel without such expertise should not
install, wire or operate EZT-430i.

housing of any EZT-430i component. If necessary, place a cover
over the components during installation and wiring. Ingress of such
fragments and chips may cause a fire hazard, damage or malfunction
of the device.

e Prevent metal fragments and pieces of wire from dropping inside the
& CAUTION: J P PPIMd

e When handling the EZT-430i B42 series loop control boards, use
proper ESD (electro-static discharge) handling procedures to prevent
damage to board components.

e Locate EZT-430i and all related control components away from AC
power/motor wiring and sources of direct heat output such as
transformers, heaters or large capacity resistors.

2.1 Enclosure Guidelines

EZT-430i must be installed correctly for reliable operation. The EZT-430i controller is designed for installation
within a suitable enclosure. Do not install EZT-430i outside of an enclosure. Care must be taken when
locating components to ensure that AC power wiring, contactors, starters, relays and other sources of
electrical interference are properly located to minimize their impact on the EZT-430i control system.

Particular note should be taken to the position of variable speed drives and switching power supplies. Their

input and load cables should be screened and properly grounded to a central equipment grounding point to
prevent radiated emissions from affecting EZT-430i operation.

Installation EZT-430i REVC 2.1
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2.1.1 Locating the EZT-430i Touch Screen Interface

It is recommended that the unit be mounted to the front panel of a steel enclosure, through an appropriately
sized opening. Proper enclosure depth is required to insure that there is adequate spacing between the rear
of the interface and the front of any high voltage devices mounted in the enclosure when the enclosure door is
closed. It is required that a minimum separation of 2" be maintained, so plan a depth to accommodate at
least 4” (102mm) behind the panel.

Proper clearance must also be maintained above, below and on both sides of the interface to allow for heat
dissipation and to facilitate mounting. A minimum of 2" is recommended. Note that additional space may be
required below and to the right of the interface (looking from rear of unit) to accommodate the
communications wiring depending upon the type of communication cables used.

2.2 Environmental Considerations

Do not subject the EZT-430i touch screen interface to operating temperatures below 0°C (32°F) or above
50°C (122°F). The operating temperature for the P41/B42 loop controls is limited from -10°C (14°F) to 50°C
(122°F). Minimum and maximum relative humidity levels are limited between 10% and 90% (non-
condensing) for the touch screen and 0 to 90% for the loop controllers. The EZT-430i touch screen interface
is to be used indoors only. The unit should not be installed where fast temperature variations may occur as
this can cause condensation of water vapor on the device.

EZT-430i should not be exposed to excessive dust, dirt, salt, direct sunlight or shock and vibration. Do not
operate the EZT-430i controller in an area where chemicals or flammable gases are present. Permitted
storage temperature extremes for the EZT-430i control system are limited to -10°C (14°F) and 60°C (140°F)
for the touch screen and -40°C (-40°F) and 60°C (140°F) for the loop controllers.

2.3 Mounting Dimensions

This section provides mounting details and dimensional information for the various components that make up
the EZT-430i control system. Note that your system may not include some of these components, and that
guantities of certain components vary depending upon the application and options ordered. Make sure that
you have all components required for your application prior to installation.

2.3.1 EZT-430i Touch Screen Interface

The EZT-430i interface is supplied with four mounting clips. All clips must be installed and properly tightened
to insure the IP65 protective rating from the front of the interface. Failure to install all mounting clips may also
affect touch screen operation. Be sure to tighten each one evenly so as not to flex the case of the unit.

Mounting Clip Slot (4 total) Mounting Clip Installed in Slot

2.2 EZT-430i REVC Installation
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NOTE: EZT-430i will not operate properly without the SD card installed into the SD card slot on the back of
the unit. The SD card has all software required, loaded onto the card for ‘Auto-Boot’ operation. The
slot on the back of the interface is ‘keyed’ so the card can only be installed in one direction. The
card is pre-installed for your convenience. If the card is removed, take care when inserting the SD
card and do not force it into the slot. The card MUST be installed before powering on the unit.
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Panel cutout; 123" x 99**
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DB9, Male Not Used LAN, Ethernet (RJ45) SD slot

DB25, Female USB port oo Power supply
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2.3.2 EZT-430i Process Loop Controllers

One PID loop controller is required for each process control loop in the system. EZT-430i is compatible with
both the P41, 1/4 DIN controller and the B41 board level controller. Refer to the CSZ controller manual for
the model of loop control being used for dimensions, appropriate mounting and installation instructions.

For applications requiring frequent access to the process controllers, the panel mounted P41 series provides
direct access to the controllers. For applications where operator access to the controllers is not required, or is
desired to be kept at a minimum, the B42 loop controllers can be mounted directly inside of an enclosure.
This also reduces wiring concerns by eliminating the need to run the sensor, communication and control
wiring for each controller to and from an enclosure door.

NOTE: EZT-430i requires firmware version V.22 or later in the P41/B42 loop control for proper manual

event operation. Early model controls can be used, but the manual event control will not function.
Only automatic ramp/soak program event control will be available.

2.4 EZT-430i REVC Installation



EZT-430i User’'s Manual Cincinnati Sub-Zero

3 Wiring

This section describes the methods and precautions for wiring the EZT-430i system components. Before
beginning wiring, be sure to read “Safety Precautions” in the beginning of this manual.

e Turn off power to EZT-430i before starting installation, removal,
WARNING: wiring, maintenance and inspection of the EZT-430i controller.

Failure to turn off power may cause electric shock, create a fire
hazard or cause damage to EZT-430i.

e Emergency stop and interlocking circuits MUST be configured outside
of the EZT-430i control system. If such circuits are made through
EZT-430i, failure of the EZT-430i control system may cause
uncontrollable operation, damage to equipment or accidents.

procedures. Since no two applications are identical, these
recommendations should be considered as guidelines. The system
designer should be aware that devices in control systems could fail
and thereby create an unsafe condition.

e This section presents recommended installation practices and
CAUTION:

e Electrical interference in an operator interface can lead to equipment
start-up, which could result in property damage and/or physical injury
to the equipment operator.

If the application requires an operator or attendant, you should be
aware that this potential safety hazard exists and take appropriate
precautions.  Consult NEMA ICS 3-304 for more information
regarding safety for the installation of solid-state programmable
control devices.

3.1 Power Requirements

The EZT-430i control system touch screen operates on a nominal 24Vdc supply voltage with an allowable
range of 11 to 36Vdc. The P41/B42 loop controls can be ordered to operate from either a DC (11-26Vdc) or
an AC (90-250Vac) supply. Do not power the EZT-430i controller components and highly inductive DC loads
or input circuitry to other equipment, with the same DC power supply used for EZT-430i.

If EZT-430i is installed in an area with poor power quality or frequent power interruptions, it is recommended
that a time delay-on relay be installed in the power supply wiring to all components of EZT-430i. This will
prevent rapid on-off cycling of EZT-430i during brown-out or momentary power interruptions. Rapid power
cycling to EZT-430i can cause damage to the electronics and/or loss of data.

Basic Operation EZT-430i REVC 3.1
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3.1.1 Installing the Power-On Delay Relay

Due to the rate at which AC/DC power supplies reach their nominal supply voltage after application of power,
the relay contact of the timer should be installed between the output of the power supply and the power input
of the EZT-430i control system components. This allows the power supply output voltage to reach its nominal
value prior to connecting EZT-430i to its output terminals.

In order to properly sense the loss of power, due to the hold-up times associated with AC/DC power supplies,

the time delay relay coil should be wired to the AC power source for the DC power supply of EZT-430i. This
will insure that EZT-430i is turned off/on at the proper times and prevent malfunction that can be caused by

rising or falling voltage at the power supply output during power interruption.

NOTE: Itis recommended that the time delay-on relay be set for a minimum period of 2-5 seconds.

AC Power Source
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3.2 Connecting to the EZT-430i Interface

Power wiring lengths should be kept to a minimum, and it is preferable to have the power wiring run using a
minimum of 18/2 twisted shielded cable. This keeps the ‘hot’ and common wires paired to minimize the
effects of external noise.

To make a connection, strip about %" of insulation off the end of the wire, turn the connector screw
counterclockwise until the gap is wide open, insert the wire all the way in, and turn the screw clockwise until
it's tight. Connect positive DC line to the ‘+’ terminal and the negative DC line (common) to the *-’ terminal.
The other end of the cable should be properly terminated at the 24Vdc power source, and the shield
connected to the main earth ground.

NOTE: Upon application of power, if the display does not come on within 2 seconds, remove power. The
interface is reverse polarity protected. Check wiring to insure proper connections and try to power
up again. An Internal fuse will prevent damage for over voltage conditions; however, it isn't
guaranteed. DC voltage sources should provide proper isolation from main AC power and similar
hazards.
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User Communications

COMA1 port, DBS male (RS232C)

1 s
0000
Loop Contreller Communications )
COM2 port, DB25 Female (RS485)
Pin Signal Signal Name Signal
18 1 number Direction
W 2 RD Receive data Input
25 T 3 D Transmit data Qutput
5 5G Signal Ground -
ki il pak Hame Binal L Note: DO NOT connect communication wiring to any pins other than
number Direction those listed.

12 TXDA | Transmit/Receive | Output/lnput | RS485
13 TXDB | Transmit/Receive | Output/Input RS485
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3.2.1 Process Loop Controller Communications

The loop controllers communicate with the EZT-430i touch screen using the RS485 communications port.
This allows one or two controllers to be connected using one 2-wire link. The controllers are wired in parallel
with each one having their own communications address of 1 and 2 (corresponding to loops 1 and 2).

Communications wiring should be run using a minimum of 24 AWG twisted-pair, copper conductors. For
short runs (< 50 feet total), non-shielded wiring can be used as long as proper separation from power/control
conductors is maintained. For communications wiring where the total length will exceed 50 feet, shielded
twisted-pair should be used.

NOTE: It is important to keep the power/control and sensor/communications wiring separated from one
another. Relay and/or high voltage outputs can interfere with the sensor and communication wiring
as they cycle on and off, which can cause erroneous sensor readings or communications errors.

CSZ recommends the use of shielded wire for all installations in order to maintain optimum
performance and minimize the possibility of communications errors.

When using shielded twisted-pair, be sure to ground only one end of the cable, preferably at the loop
controller. Allowing any other portion of the cable shield to come in contact with ground, or grounding both
ends, will cause ground loop currents to flow in that section of the cable shield which can disrupt
communications.

B42 Loop Control Board

SHIELD ir )
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= COM TXDB o

HS El
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P41 1/4 DIN Control 13 12
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T 17
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3.2.2 User Serial Communications

The EZT-430i touch screen provides an RS232C user communications port for connecting EZT-430i to a PC
running software such as CSZ's Envision. In order to connect EZT-430i to a PC, a cable must be made
according to the diagram below.

= —|—.,1_| |_r,.—|— =
|l [ 5 a  ||]
= _I_f_| ﬁ_l_ P
D-sub 9-pin Female Connector Pinouts D-sub 9-pin Female Connector Pinouts
Description Pin Pin Description
Shield Cover Cover | Shield
RXD Receive Data 2 2 RXD Receive Data
TXD Transmit Data 3 3 TXD Transmit Data
SG  Signal Ground 5 5 S$G  Signal Ground

NOTE: DO NOT use a standard null-modem cable to connect EZT-430i to a PC. Most computers do not
provide a standard serial port and a USB to serial converter must be used. Incompatibilities may
exist between EZT-430i and certain USB to serial adapters which will cause EZT-430i to
malfunction when connected using a standard null-modem cable.

If more than one EZT-430i controller is to be placed on the communication link with a PC, an RS232/485
converter will be required for each EZT-430i in order to convert the RS232 communications port to RS485
multi-drop communications for connecting multiple EZT-430i controllers on the PC communications link.
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NOTE: The connection requires a single twisted-pair cable that is daisy-chained from one EZT-430i to the
next. When using shielded twisted-pair cable, be sure to ground only one end of the cable, preferably
at the RS232 to RS485 network adapter. Allowing any other portion of the cable shield to come in
contact with ground, or grounding both ends, will cause ground loop currents to flow in that section of
the cable which can cause communication errors.

If you encounter a problem with your EZT-430i controller, review all of your configuration information to verify
that your selections are consistent with your application: inputs; outputs; alarms; limits; etc. If the
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problem persists after checking the above, you can get technical assistance by dialing 1 (513) 772-
8810 or by faxing your request to 1 (513) 772-9119, Monday thru Friday, 7:30 a.m. to 5:30 p.m.
Eastern Standard Time. You can also email your request to indsales@genthermcsz.com

An applications engineer will discuss your application with you.
Please have the following information available:

» Complete Model #'s and/or Serial #'s for Component(s) in Question
» Complete Software Version #'s

« All Configuration Information

* All User Manuals

Warranty and return information is on the back cover of this manual.

Your Comments

Your comments or suggestions on this manual are welcome. Please send them to:
Telephone: +1 (513) 326-5252; fax: +1 (513) 326-5258

support@cszproducts.com
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4 Basic Operation

This section is designed to help guide you through the EZT-430i touch screen interface and menu structure,
so that you can navigate through the various operation, monitor and setup screens and learn how to use
them. Subsequent sections of this manual are tailored to the special features and functions of EZT-430i.
Consult those sections of the manual for further information and specifics on how to set up and operate them.

4.1 Configuration Options

The availability of certain menu items, screens and the functionality of EZT-430i are determined by the
configuration of the loop controller(s). This manual covers all available options, some of which may not be
available on your system.

4.1.1 Loop 1/2 Monitor Mode

The loop ¥ monitor and loop 2 monitor configuration modes of EZT-430i provides an a low cost video
recorder option to use in place of a standard one or two pen circular chart recorder. When the loop ¥ monitor
function is enabled in the Configurator, EZT-430i automatically configures itself to remove all set point fields,
automatic ramp/soak program control options, loop tuning and set point limit access so that only the loop
process value (PV) is available.

4/23/2013 4/23/2013
| 2:55PM 255 PM

- Single View - - Dual View -
Unlike your basic chart recorder; however, the loop controls are still functional. They can be used to control a
process if there is the need for fixed, single set point control. A loop can be programmed with a fixed set point
by the OEM, and it will then control the process in the background without the need for any user access.

If one control loop is required while another point is for recording only, selecting the loop 2 monitor function in
the Configurator will remove the set point fields, loop tuning and set point limit access for loop 2 only. Loop 1
will maintain all control functions including the automatic ramp/soak program operation, while loop 2 will be
shown as a monitor only point for recording purposes.
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4.2 Touch Screen Interface

The EZT-430i display is split into two sections; the icon bar and main display area.
ST © h A
b
L

Main Display —,

LOOP 1

= lc 100.0 %

| Manual Control | Automatic Tune

Single Loop View Screen

The menu icon will open the main menu for navigating to the different control and
monitoring screens. Menu items will dynamically appear providing available options
based on the system area the user is in, i.e., security, data logging, setup, etc.

P )\ The information (help) icon will display text based help associated with the current
l\WJ screen. Help is available in 28 languages based on the user selection in the offline
" setup of section of EZT-430i.

T . . . . . .
) The home icon will return the user to the main view from anywhere in the EZT-430i

] - [ application. The main view is set by the OEM in the EZT-430i configuration and can be
—- . the single or dual loop, chart, alarm, alarm history, event or digital 1O view.

The alarm icon will appear and flash when a new system alarm occurs. Pressing the
alarm icon will take the user directly to the alarm monitor screen in order to view and /or
reset the active alarm condition.

The left and right navigation arrows will appear on screens that provide additional
/q_| \_|/ information that the user can scroll to such as the loop view screens, charts or program
entry screen in order to cycle through each step of a ramp/soak program.

The up and down navigation arrows will appear on screens that provide list views in
} {7 order to scroll up and down through items of the list. List views also provide “touch
sliding” like other modern smart devices.

NOTE: A single press of the left/right or up/down arrows will scroll list views to the next list item, program
steps to the next step or screens to the next available loop or chart. Pressing and holding the
arrow keys will continue the item scrolling until the end of the list is reached or the button is
released.
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IMPORTANT: Do not use any sharp or metal objects on the touch screen as they may damage the surface.
Also be sure that hands and fingers are free from oils or chemicals which may mar the

surface of the touch screen.

4.3 Menu Navigation

EZT-430i provides the user with the ability to select text based menu navigation, much like the typical file
menu system of a PC, as well as an icon based navigation system like that of a “smart” device. The user can
switch back and forth between the two from the Setup menu.

4/23/2013 « »
2:55PM

Program »

Device

Security »| Alarm File

Data v| Events || Automatic Tune |

Text Based Navigation

T A
-

] =
Single Dual Events

L
it Alarm alarm File

¥
between menu £, _ Indicator (1 of 3)

pages.

Touch and drag
finger across

screen to switch Active Page

Settings

Icon Based/Slide Page Navigation

The available menu items are dependent upon the OEM configuration of EZT-430i. Not all of the menu items
shown may be available on your system. The following information is provided as an overview of the full
navigational menus for EZT-430i.
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4.3.1 Home Menu

The home menu is the top level, default menu provided when EZT-430i first powers on. Pressing the menu
(monitor) icon will display the main menu offering the selections shown below.

4.3.1.1 Text Based Home Menu

W The View menu provides navigation to all standard view screens. These

Dual include the Single and Dual loops views, real time Charts, Alarm monitor, Alarm
Program » File and Events control screens.
| Chart
Device » Alarm

Security »| Alarm File

Data »| Events

The Program menu provides access to the automatic ramp/soak program
actions, Entry and Status views. The program Start, Hold and Halt menu items
allow quick access to these functions if a program is already downloaded to the
EZT-430i loop controls.

Device »

| Start
Security » Hold
Data | Halt
View  » The Device menu provides access to the EZT-430i controller settings. These
include, loop set point entry limits, alarm set points, communication settings,
Program » email setup as well as access to offline settings for date/time, etc.
Security »
Data v
Canfigure The Security menu provides access for user login, security settings and audit
View _ trail viewing if the security system is enabled.
*| Login

Program»| Log Off

Device | Audit

Data »| Password

View The Data menu provides access to data log functions, file utilities, FTP\WAN
_ back-up settings as well as the historical data viewer.

Program»

Device »

Security »
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4.3.1.2

4.12

Icon/Slide Page Based Home Menu

Configure

Password

EZT-430i REVC

Dual

X
\
I ]

LT

Status

(m,

4/23/2013
3:10 PM

4/23/2013
3:10 PM

4/23/2013
3:10 PM

o

Events

Alarm File

A= =y
>

Rl <

Slide page 1 provides navigation to
all standard view screens. These
include the Single and Dual loop
views, Event control, trend Charts,
Alarm monitor, and Alarm File.

It also provides quick access to the
EZT-430i Settings and Data file
functions which include file utilities,
FTP\WAN back-up settings as well
as the historical data viewer.

Slide page 2 provides access to
automatic ramp/soak program
actions, Entry and Status views.

Start, Hold and Halt program menu
items allow quick access to these
functions if a program is already
downloaded to the EZT-430i loop
controls.

Slide page 3 provides access to
security settings, Audit trail viewing,
current User information, user
Password editing and user Login
and Log Off functions.
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4.3.2 Automatic Ramp/Soak Program Menu

The automatic ramp/soak program menu is provided when the user selects either “Entry” or “Status” from the
Program menu. The menu provides all functions related to the creation, editing and operation of programs.
See section 5 on Automatic Ramp/Soak Program Operation for detailed information on how to create and run
programs.

4.3.2.1 TextBased Program Menu

Fle | Entry

The View menu provides navigation to the program view
screens. These include the Status and Entry screens.

Step b

Program »

New
The File menu provides functions needed to create,
Step Open open, save and delete automatic ramp/soak programs.
»
| Save
Program»| gayve As
Delete
View »
— | Insert
File 1w
cmove The Step menu provides all of the functions needed to
Step b Copy edit programs. These include Insert, Remove, Copy and
— Paste step functions as well as the Clone event function
Program » Paste which allows the user to transfer the current step event
selections to all following program steps with a single
Clone click to simplify and speed program entry.
View »
File v
- The Program menu provides the program control
Step g selections for Start, Hold and Stop.
| Start
)
Jole Hold
Halt
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4.3.2.2 Icon/Slide Page Based Program Menu

4/23/2013 Slide page 1 provides navigation to
3:14 PM ‘ * the program Status and Entry

screens and also provides access to

the functions needed to create,
a m open, save and delete automatic
ramp/soak programs.

ntry Status
ave

2 B

Save As

4/23/2013
314 PM Slide page 2 provides all of the

functions needed to edit programs.
These include Copy, Paste, Insert
- and Remove step as well as the
Clone event function which allows
Insetk the user to transfer the current step
event selections to all following
program steps to simplify and speed
program entry.
Clone

4/23/2013

2149 PM Slide page 3 provides the program
control selections for Start, Hold and
Halt.

4.14  EZT-430i REVC Basic Operation



EZT-430i User’'s Manual Cincinnati Sub-Zero

4.3.3 Device Settings Menu

The device settings menu is provided when the user selects “Settings” from the main “Device” menu. See
section 8 on Device Settings for detailed information on these settings and their use.

43.3.1 Text Based System Setup Menu

S Tuning
, The View menu provides navigation to the manual loop Tuning
et
screen.
Email »
Offline »
View
- Alarm
o The Set menu provides access to settings Alarm set points,
] Limit control loop set point Limits, Event tagnames, Navigation
Email » type selection and Communications options.
| Event
Offline »| Navigation
Comms
View The Email menu provides settings for the email server to
send SMS text messages and/or emails on alarm and allows
Set the user to compose and send a Message to any user
€ ’ configured in the system.
2 Email
Offline »| Message
View _ _ oo
The Offline menu provides access to the EZT-430i offline
Set setup which provides the user with the ability to adjust the
€ ’ date/time, calibrate the touch screen, configure profile power
- recovery options, etc.
Email »
oliill =Ny Offline
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4.3.3.2 Icon/Slide Page Based Device Settings Menu

Nawigation

Tuning

4.3.4 Offline Menu

The Setup slide page provides
access to the EZT-430i controller
settings. These include options for
Navigation type, control loop set
point Limits, Alarm set points, loop
Tuning, Event tagname entry and
Email server settings and
Messaging.

It also includes access to the
communications settings for the
web page, VNC server and
Modbus user communications.

The offline menu is provided when the user selects “Offline” from the device settings “Offline” menu. See
section 9 on Offline Settings for information on these settings and their use.

NOTE: Offline settings can only be accessed when an automated ramp/soak program is not running and

data logging is turned off.

434.1 Text Based Offline Setup Menu

e Settings
Set »
Calibrate »
System »
View ’

e Recovery
Calibrate »| Units
System | Clock

Language
View »
Set »

=]zl Offset

416 EZT-430i REVC

The View menu provides navigation back to the EZT-430i device
settings menu.

The Set menu provides access to the profile power Recovery options,
temperature Units selection, NTS Clock, and Language settings.

The Calibrate menu provides access to the user input Offset
calibration for the control loop inputs.

Basic Operation
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View

Set 3

Pl The System menu provides access to the EZT-430i Display

Configuration settings, import/export Configuration utility, About screen and
About Exit application screen.

Exit

Calibrate »

4.3.4.2 Icon/Slide Page Based Offline Menu

Slide page 1 provides navigation
back to the device Settings menu,
Clock, Display settings, About
EZT-430i and Exit application
c.":""_\; screens, temperature Units

selection, Language, import/export
Configuration utility and input

- .’_‘ Offset calibration.
| ’

About Units

Language Configuration Offset

Settings X Display

Slide page 2 provides access to
the automated program power
Recovery options.

i

Recovery
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4.3.5 DataMenu

The data log menu is provided when the user selects “Data” from the main “Data” menu. See section 7 on
Data Logging for information on these settings and their use.

Text Based Data Logging Menu

435.1
= Annotation
File Signature
Data
Chart »
Utilities »
View
e Open
Data Delete
Chart
Utilities »
View
File '
Data Data
“Chart | Assign
Utilities »
View
File »
Data
3 Set
Utilities »| Chart
View
File »
Data U
Chart » FTP/WAN

niﬂﬁ Memary

418 EZT-430i REVC

The View menu provides access to the data file Annotation and digital
Signature screens.

The File menu provides functions for opening and deleting historical
data log files.

The Data menu provides access to the main Data screen for starting
and stopping data logging and to the log point Assignment screen
where the user can select which items are to be logged to the history
file.

The Chart menu provides functions for viewing historical data files in
graphical format.

The Utilities menu provides access to the EZT-430i file management
utilities including USB file transfer and FTP/WAN back-up.

Basic Operation
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4.35.2

Icon/Slide Page Based Log Menu

Memory

Basic Operation

4/23/2013
3116 PM

4/23/2013
3:117PM

Open

Signature

Slide page 1 provides access to
the main Data log screen and to
the log point Assignment screen
where the user can select which
items are to be logged.

Historical data file functions are
provided for Opening and Deleting
historical files and viewing/setting
data file Annotations and digital
Signatures.

The plot Set and Chart icons
provide access to the historical
data viewer options.

Slide page 2 provides access to
the FTP/WAN back-up settings
and the memory check utility for
viewing available system/storage
memory space.
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4.4 Notifications

The notification window is a feature that can be accessed by pressing the date/time field in the icon bar. This
window provides a snapshot of current EZT-430i activity. The naotification window can be closed by pressing
the date/time field again, or is automatically closed if the Menu, Home or an arrow icon is pressed.

4/23/2013
- 3:21PM

LODP 1
PY = 25.0 5P = 30.0
Program
Inactive

Alarm
Inactive /
Data /

Inactive Y
Data 4
Length{days): 1

| Manual Control

A user can view all notifications by touching the screen and dragging their finger up or down on the list to
scroll through all items like other lists in EZT-430i. The notifications include the following:

* Loop PV and SP for each loop configured.

» Automatic program status including name of running profile.

» Active alarm status including the most recent alarm.

» Data logging status including active file name and the length and logging rate set.
e Security status including the current user.

» Audit trail active/inactive status.

» Web server active/inactive status.

* VNC server active/inactive status.

o EZT-430i IP address.

» Available SD storage memory remaining.

The appearance of the items is based on the configuration of EZT-430i. If data logging or security functions
are disabled in the configurator for example, their status items will be removed from the list as well.

NOTE: The notification items do not update while the list is shown. The information shown in the list is a
snapshot of the data at the time the window was shown. Therefore, the PV or SP shown for a loop
may not be the actual values for the loop if the notification window is left open for extended periods
of time. The notification window is not available in the offline setup.

4.5 Control Loops (Single Set point Operation)

The loop view screens provide direct viewing options for the control and monitoring of the EZT-430i control
loops. The loop screens allow the user to adjust the current loop set point (SP) and view the process
variables (PV) and percentages of output (%) for each loop.

420 EZT-430i REVC Basic Operation
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45.1 Single Loop View

The Single loop view display shows one control loop at a time. It is accessed from the home “View” menu.
The screen provides special loop control functions not available on the Dual loop view screen. These special
functions are accessed by the Manual and Automatic Tune control buttons.

4/23/2013
2:55 PM

Loop Units

| Manual Control | Automatic Tune

The left and right arrow buttons allow you to switch between each loop in the system on a dual loop
system. If EZT-430i is configured as a single loop system, the left and right arrow buttons will not be shown.

The loop name, shown at the top right of the loop view, will update as each loop is shown. The unit display
field will update as well, in order to provide the user with the units of measurement for the selected loop.

The set point entry field is the area where the screen can be touched in order to bring up the keypad entry
window. Using the numeric entry keypad, a new set point can be entered. Once entered, the new set point
will be shown in the set point entry field. Adjustment of the set point is locked out if an automated ramp/soak
program is running.

IMPORTANT: When operating in single set point mode, the set point is saved in the loop control board’s
memory once every 5 minutes. If the set point is changed and power is removed prior to the
5 minute time period, when power is re-applied, the loop set point will return to the previous
value.

Make sure that power remains on the unit for 5 minutes after a set point change in order to
have it power-up with the desired set point the next time power is applied.

The special loop control function buttons, Manual and Automatic Tune are used to define the mode of
operation of the loop. These functions will not be available during automatic ramp/soak program operation.

Manual Control - This button switches the loop mode between automatic and manual operation. When
the loop is in automatic mode, the loop will automatically adjust its output based on its
PID settings. When the loop is in manual operation, the percentage of output for the
loop can then be set manually, to a fixed output percentage.

To switch the loop between auto and manual operation, press the button to place the
loop in auto or manual mode. When in manual mode, the button’s indicator will be on.
To adjust the loop output percentage when in manual operation, touch the percent
output display field and enter the desired percentage of output. If the loop is
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configured for heat/cool operation, enter a positive value for heating and negative
value for cooling.

Automatic Tune - This button initiates the loop controller's auto tune function. During the auto tune
procedure, the Automatic Tune button indicator will be on to show the tune is in
progress. When the tune is complete, the button’s indicator will automatically turn off
to indicate the tune is complete. If at any time during the tune process, you want to
cancel the auto tune, press the button to cancel the tune.

45.2 Dual Loop View

The Dual loop view shows both control loops on a single screen. It is accessed from the home “View” menu.
If EZT-430i is configured as a single loop system only loop one will be shown. The screen allows manual set
point entry for each loop by touching the respective set point entry field.

1/23/2013
2:55 PM

LOOP 1

100.0 %
LOOP 2

100.0 %
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4.6 Event Control

Events are the “switches” used to turn the digital outputs of the EZT-430i loop controls on and off. These
events can be manually turned on and off as well as programmed into automatic ramp/soak programs so that
they can be turned on and off at set time intervals.

NOTE: The EZT-430i loop controls can provide up to 3 event outputs each (for a total of 6 events).
Depending upon the configuration of EZT-430i, some outputs may perform specific control or alarm
functions.

[This is an example showing factory default event names. Consult section 8.3 on Event Names in
order to see how to change the names of events.]

4/23/2013
= 2:55 PM

Event

To turn the events on and off, select “Events” from the home “View” menu. Press the switch for each event
that you want to turn on or off to toggle the on/off state of the event.
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4.7 Process Monitoring

The loop view screens provide the current process values of EZT-430i. In order to view the process inputs
over time, EZT-430i provides real-time charts. Four user configurable charts are provided with up to six plot
points per chart.

471 Charts

The Chart screen is accessed from the home “View” menu. The real-time charts can be configured to display
the process variable (PV), set point (SP) and percentage of output (%) of each control loop over a selectable
period of time. The vertical axis determines the range of displayed data while the horizontal axis determines
the history period. The maximum time period that can be shown in a chart is 24 hours.

The rate at which the chart plots a new point is based on the time period to be shown. Each buffer can hold a
total of 720 readings for each of the selected channels to plot. The update rate can be calculated by the
formula: time period (in minutes) * 60 / 720. Note that for time periods less than 72 minutes, the update rate
will be held to a minimum of 6 seconds. Thus, the update rate will vary from a minimum of 6 seconds (for
time periods of 72 minutes or less) up to a maximum of 120 seconds for 1440 minutes (24 hours).

Chart 1 Labels | Set |

LOOP 1 PY = 18.9C

The Labels button allows the user to cycle through each of the configured plot channels to determine what
each colored plot represents as well as view the current value without having to return to the Single or Dual
view screens. The left and right scroll buttons at the upper right of the screen allow the user to cycle through
each of the four available charts.

The charts also allow you to “zoom in” on a particular area to have a more detailed look at current data. By
using your finger to select an area on the screen, the chart will zoom in on that area. To select a portion of
the plot, touch and hold the screen with your finger. Drag your finger across the graph and a box will be
drawn around the selected area. Removing your finger from the screen will cause the chart to redraw with
only the selected plot area. To return to the normal view, touch the ‘X’ or ‘Y’ axis and select zoom out to
return to the previous zoom setting or zoom normal to return to the full display.

NOTE: When a chart is zoomed in, it will not update with new information. The chart must be in normal view
mode in order to update at each time interval. The chart will return to normal automatically when
selecting a different screen to view.
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4.7.1.1 Chart Setup

To configure a chart, press the “Set” button in the upper right corner of the display. The setup screen will be
shown. To assign channels to the chart, simply touch the on/off button for the desired items in the list to
select them. Select the left or right vertical axis for each item by selecting the item in the list and press the
button for the desired “Left” or “Right” axis. The left axis is the default axis selection. If none of the channels
are assigned to the right axis, the axis will not be shown on the chart.

Select a button on the screen. f .

Chart 1 Cancel | Save |
[ oN | LOOP 1 PV
[ oN | LOOP 1 SP

OFF  LOOP 1 %0ut

Asis Left Right
orr JENNCN |

Once the channel selections have been made, press the “Axis” button to adjust the time period and vertical
axis ranges of the graph.

Select a button on the screen.

Axis 1 Return |
Time Period (minutes)

Left Right

Maximum 100 Maximum 100

Minimum |I| Minimum
-100

Automatic Scale Automatic Scale

Time Period - Adjusts the displayed time period for the graph. The allowable range is from 4 to
1440 minutes (24 hours).

Maximum - The maximum value sets the maximum range of the vertical access with a minimum
value of -32,760 and a maximum of 32,760.

Minimum - The minimum value sets the minimum range of the vertical access with a minimum
value of -32,760 and a maximum of 32,760.

Automatic Scale - When on, the vertical axis will automatically adjust its zero and span as needed to
display the selected plot channels.
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4.8 System Alarms

When an alarm condition occurs, the alarm icon flashes in the EZT-430i icon bar, to provide a visual
indication of an alarm condition. An audible alarm will also sound if the alarm requires immediate operator
attention such as a loop communications failure or a process alarm set point has been exceeded. For more
information on adjusting the audible alarm volume, see Section 9.12.3, Alarm Volume.

NOTE: The EZT-430i loop controls can provide up to 3 alarm outputs each (for a total of 6 alarms).
Depending upon the configuration of EZT-430i, some outputs may perform specific control or event
functions.

For information on alarm operation, see Section 8.4, Alarm Settings.

4.8.1 Alarm Monitor

The Alarm screen is accessed from the home “View” menu. It can also be displayed by pressing the alarm
icon whenever a new alarm occurs. It displays all current and/or previously acknowledged alarms according
to time and date of occurrence. Once the alarm is reset, the alarm icon will be hidden; however, the alarm
condition may still be present.

HEORA 2V

Alarm Reset Clear

LOOP 1 sensor break
4f23/2013 294 PM

The alarm will be removed from the list when cleared by the operator by pressing the “Clear” button. Only
alarms that are not currently active in the system can be cleared from the alarm list.

IMPORTANT: If a control loop is in manual mode or in automatic tune and the reset button is preset, the
alarm reset will terminate automatic tune or manual mode and place the loop back into
normal operation.

Upon alarm reset, if the process no longer exceeds the alarm set point, but the alarm output

has not yet reset due to the alarm hysteresis, the alarm reset will ignore the alarm hysteresis
and the alarm output will immediately go to the non-alarm output state.
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4.8.2 Alarm File

The Alarm File screen is accessed from the home “View” menu. It displays all alarms for any given day.
EZT-430i can store daily alarm files for a period of a year or longer (time based on storage usage for data
history). Each time an alarm occurs on EZT-430i, the alarm is written to a file. Alarm file names are listed as
month_day_year. The “Open” file button will display a dialog box where the user can select any alarm file to
view.

NOTE: If no alarms occurred on a given day, an alarm file will not be created for that day.

4/23/2013
- 2:55 PM

Alarm File < Open

FTP failure. Check cable and server,
1/10/2013 10:20 AM

The send email icon 2= allows the user to send a copy of the currently opened alarm file to any user
configured in EZT-430i. When the email icon is pressed, an “Add Recipients” window will be displayed where
the user can select recipients for the file from any of the email addresses configured under the EZT-430i
email settings. For information on how to add email recipients to EZT-430i, see the section 8.9, Email.
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5 Automatic Ramp/Soak Program Operation

A ramp/soak program is a set of instructions (set points and events) programmed as a timed sequence of
steps. When a program is run, EZT-430i executes each step of the program automatically, in sequence,
based on the time duration and settings for each step. EZT-430i can store hundreds of automatic ram/soak
programs (depending on storage usage for data history) with up to 64 steps in each program.

The menu provides navigation to the following functions:

Status View menu
e Status: View program operation; step #, time remaining, etc.

File , Entry Entry: Functions for creating/editing programs.
Step »
Program »
- File menu
Yiew r New: Clears all current program entries.
New Open: Provides file open dialog to select a program from memory.
Save: Saves the current program being edited.
0 Save As: Saves the program being edited under a new name.
Pen Delete: Deletes the current program from internal memory.
Step 8
| Save
Program»| gayve As
Delete
View , Step menu
Insert: Inserts a step into the program at the current step number.
Fil Insert Delete: Deletes the current step.
e ' Remove Copy: Copies current step data including events.
== Paste: Pastes previously copied step data to the current step.
Step d Copy Clone: Copies and pastes current step events to all following steps.
Program »| Paste
Clone
i Program menu
View » :
Start: Transfers current program to loop control(s) and starts it.
. Hold: Places a running program in hold.
File ¢ Halt: Stops a running program and returns the loop controls to
—— single set point (static) operation.
Step ’
| Start
)
wahd Hold
Halt
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5.1 Entering a Ramp/Soak Program

Ramp/Soak programs are created and edited from the program Entry screen. The program Entry screen can
also be accessed directly from the “Program” menu. To create an automatic ramp/soak program:

1.) From the File menu, select “New” to create a new program.

2.) Enter the number of steps that will be in the program you want to create. The default setting, and
minimum number of steps is two. You can only adjust settings for step numbers within the range of 2 to
the Max Steps entered (maximum of 64). Thus, to adjust settings for step 5, you must have the Max Steps
set to a value of at least 5.

NOTE: The number of steps can be changed at any time during the program entry to shorten or
lengthen the program as required without affecting steps already programmed.

3.) For each step, enter the step events, set point(s) and time duration or ramp rate (depending upon the
ramp unit’s selection). Example shown below with step time (HH:MM).

4.) From the File menu, select “Save” to save the program.

NOTE: Programs can be saved with names of up to 16 characters long. However, EZT-430i only uses
the first 14 characters of the program name for display updates and record keeping. When
naming programs, try to keep the name limited to 14 characters in order to have the full program
name shown, or use the first 14 characters as a means of more clearly identifying the program
when more than 14 characters are used in the name.

423-"'2013 ‘ *

Max Steps

Hold Band LOOP 1 Loop 2

S1: Touch Here
Ramp hh.mm =0
LOOP1=0
LOOP2=0

The Ramp units selection is a global selection that applies to all steps of the program. It allows the user to
select the method of ramp step entry. Selections include ramp entry in units of time as either hours and
minutes (hh.mm) or minutes and seconds (mm.ss). Single loop EZT-430i systems also provide ramp entry
selections in units/hour or units/minute. This allows the user to enter a ramp rate rather than time.

The Soak units selection is a global selection that applies to all steps of the program. It allows the user to
select the method of soak step entry. Selections include units of time as either hours and minutes (hh.mm) or
minutes and seconds (mm.ss).

The Hold Band entries are global settings that apply to all soak steps of the program. Their availability is

dependent upon the configuration of EZT-430i. See section 5.1.6, Hold Back Operation, for more information
on the use of hold back.
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5.1.1 Setting Step Set Points and Time

Programs are entered as a sequence of ramp and soak steps which define the set point and length of time
that a loop should remain. The ramp and soak units can both be set for hours and minutes, minutes and
seconds or one can be set for hours and minutes while the other is set for minutes and seconds.

Set point entry is only provided when entering a ramp step. If “soak” is selected for the step type, the loop(s)
will remain at the previous set point for the amount of time entered for the step. The set point entered for
each control loop is used as the target set point for the step, i.e., the set point the control loop will arrive at by
the end of the step. Each set point will change independently of the other in order to arrive at the target set
point when the time left in the step reaches zero.

To enter the set point(s) and/or time for a step, touch the time/set point list view at the bottom of the Entry
screen. This will display the “Step Data” screen. Begin by selecting the desired ramp or soak step type
(available selections are ramp, soak, jump and end). The jump and end step types are discussed in the
following sections.

To enter the set point for a loop, touch the set point field for the loop and enter the desired set point. To enter
the step time, touch the time field to enter in the desired time duration. Time is entered as HH.MM or MM.SS
depending upon the selection chosen on the entry screen. Thus, to enter a time of 1 hour for example, you
would enter a value of 1.00 for one hour and zero minutes. To enter a step time of 30 minutes, the time entry
would be made as 0.30 for 30 minutes. If the time selection was in minutes and seconds, an entry of 1
minute and 30 seconds would be made as 1.30.

R [ IO R
S1: Step Data Return | S1: Step Data Return |
Hours/Minutes Hours/Minutes |I|

[o ]
LOOP 1 5P |I|
[o ]

LOOP 2 5P

Ramp Step Entry Soak Step Entry

If one loop is to remain at the same set point for the step while the other is required to ramp to a different set
point, select “ramp” for the step type. Since the set point entry defines the target set point for the step, if the
set point entered matches the set point for the control loop from the previous step, the loop will soak, i.e.,
soak at that set point, for the entire step. Thus, one loop set point can be changed allowing it to ramp during
the step while the other soaks.

NOTE: A step time of zero can be entered for a step to implement an immediate set point change. When
coupled with a hold back condition on the following step, there is no need to know the time it takes
for the process to reach set point. The hold back condition can be used to trigger the next step,
typically a soak, so that the desired soak time is achieved without having to determine what
additional time may be needed in order to make sure that the process reaches set point before
starting the soak time.

The Hold selection is only available for soak steps on single loop EZT-430i systems or dual loop systems that

are configured to use external hold control. See section 5.1.6, Hold Back Operation, for more information on
the use of hold back.
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IMPORTANT: If the first step of a program is programmed as a soak step, the target set point shown on the
status view screen during the first step will not indicate the correct set point. It is
recommended that all programs be entered with the first step as a ramp step so that the
target set point will be indicated correctly to avoid operator confusion.

5.1.2 Setting Step Set Point and Ramp Rate (single loop only)

If the ramp units are set for units/hour or units/minute, ramp steps are entered in process units/time period. If
the user enters a set point that matches the set point of the previous step, the step will be skipped since the
loop is already at set point.

NOTE: A ramp rate entry is only available for single loop EZT-430i systems because the length of time for
the step to complete is based upon the change in set point and the rate at which the set point is to
ramp. Ramp units of time are still available for selection on single loop systems if time entry is
preferred over rate.

4/23/2013 ‘ *
g 4:24 PM

S1: Step Data Return |
Type m Units/Minute |I|
LOOP 1 5P |I|

5.1.3 Setting Step Events

For each step of the program, the user can select which events are to be on during the step. To edit step
events, press the “Events” button on the program Entry screen. This will display the step Events screen.

4/23/2013 ‘ *
g 4:24 PM

S1: Events Return |
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You can then select which events are to be on during the step by touching each event toggle switch to turn
the events on or off. The light on the event buttons will illuminate bright yellow to indicate that an event is on.
Pressing the left or right arrow button will allow you to scroll through each step of the program and not have to
leave the step Events screen. To return to the Entry screen, press the “Return” button or select “Entry” from
the View menu.

Events cannot be set for the End step. During program operation, when the End step is reached, the event
outputs will return to their previous static setting (prior to starting program operation). If the loop controls are
configured for “Final SetPoint” at end of program operation, the program will remain in the end step state and
all event outputs will turn off and remain off until the user halts program operation. Upon stopping the
program, the event outputs will then return to their static settings.

NOTE: The step events must be set individually for each step. Even though a ramp/soak program may be in
operation, if the events are not set, the associated loop control output will not turn on. To make
setting step events quick and easy, EZT-430i provides the “Clone” function from the “Step” menu.
When selected, all event selections of the current step will be copied to all following steps.

This requires the user to only enter event selections for one step (step 1 for example), and if all
following steps use the same event selections, selecting “Clone” from the “Step” menu will then copy
the selections to all other steps of the program.  This feature can be used on any step of the
program, so if event selections then change on step 5, the function can be used again and all steps
after step 5 will then have event selections of step 5 copied to them leaving steps 1-4 with the
previous selections.

5.1.4 Setting Jump Steps

This feature allows the program to jump back to a previous step in order to repeat certain sections of a
program. When a jump step is entered, the program will jump to the specified “jump step” rather than
continuing on to the next step in the program. After all of the programmed jump cycles have been completed,
the program will then continue to the next sequential step without making any further jumps.

23/2013 ‘ *
4PM

S7: Step Data Return |

Jump To Step Cycle Count

To program a jump step, select jump for the step type and enter the step number that you want the program
to jump back to along with the total number of times the jump is to be made. A cycle count of one indicates
that no jump will be made since one cycle is completed upon reaching the jump step.
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NOTE: EZT-430i has the ability to do nested looping by allowing multiple jump steps to be programmed
throughout a program. The Status screen will provide the current cycle count; however, this is the
cycle count of the current jump loop that the program is in. If nested jump loops are programmed,
this can cause operator confusion if they do not know which jump loop the program is currently in
based on the current step number.

5.1.5 Setting the End Step

All programs require that the last step is entered as an “End” step type regardless of the length (2 to 64 steps)
of the program. The end step type provides a cycle count entry which makes it easy for the operator to repeat
an entire program without having to enter a jump step. The end step cycle count can be set from 1 to 9999
cycles. An entry of 10,000 can also be made which signifies infinite looping. If the user enters 10,000 for the
cycle count, the program will repeat indefinitely until stopped by the user.

4/23/2013 « *

S10: Step Data Return |

Cycle Count

If EZT-430i is configured for automatic program final set point entry, the loop set point of one or both loops will
be present. When the program ends, the set point entered on the end step will be used as the loop set point.
The loop control will then remain at that set point until the user halts the program. The loop control will then
return to the previous static set point (prior to the start of the program) once the program is stopped.

The EZT-430i configuration also provides the option for having the loop controls return to the static mode of
operation when the program is completed. When configured to use the last control set point, the loop controls
will automatically return to the previous static set point (prior to the start of the program) when the program
ends.

NOTE: When configured for automatic program final set point entry, EZT-430i will remain in the end step until
the user manually stops the program. If any loop control outputs are configured as events, they will
remain in the off state and cannot be turned back on until the program is stopped.

5.1.6 Hold Back Operation

The hold back band settings on the Entry screen are used to set the control tolerance for each loop during
soak steps that have hold back enabled. When the loop process variable deviates from its set point by more
than the band value, the program timer will stop until the process variable re-enters the hold back band.
These entries apply to every step in the program and only need to be set once.

To enable hold back for a loop, select the hold back type to use for the corresponding loop during the step.
When the step executes, the program will automatically enter a hold condition if the loop’s PV deviates from
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its set point by more than the hold back band setting. There are four available hold back modes to choose
from:

Off Disables hold back so no action is taken.

Dev Lo Deviation low hold back places the program in hold when the process value deviates below the set
point by more than the hold back band.

Dev Hi  Deviation high hold back places the program in hold when the process value deviates above the set
point by more than the hold back band.

Band Deviation band hold back is a combination of both the deviation low and high hold back types. It
places the program in hold when the process value deviates above or below the set point by more
than the hold back band.

5.2 Starting an Automatic Ramp/Soak Program

In order to start an automatic ramp/soak program, it must first be loaded into the EZT-430i control loops. In
order to do this, you must select “Start” from the Program menu.

4/23/2013 « *
o 4:24 PM

Program » [P

LooP 2 = 50.0] Halt

The screen will automatically change to the Start screen. By default, a program will always start on step 1. If
you wish to start the program on a different step, press the start step field and enter the desired start step or
use the left and right scroll buttons to adjust the step number.
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Start Step

KN NN

Once the desired start step number is entered, press the “Start” button. The program will then be transferred
to the loop control(s) and started once the transfer is complete. The Status screen will then be displayed.

NOTE: If EZT-430i was configured for delayed start of an automatic program, the program will not begin
running until the start delay period has expired. Contact your OEM for further information or
guestions regarding the configuration of your EZT-430i control system. Only your OEM can
address equipment related issues.

To stop a program, select “Stop” from the Program menu. When a program is stopped, the loop set points
and events will revert back to the single set point (static mode) values that were entered prior to the program
being started.

5.2.1 Hold/Resume Ramp/Soak Program Operation

At any time during the operation of a program, it can be manually placed into hold. This stops the program
timer; however, EZT-430i continues operation under the current step settings at the time the program was put
into hold. To pause a program, select “Hold” from the Program menu. To resume the program from the point
in which it was paused, select “Start” from the Program menu.

5.3 Monitoring Automated Ramp/Soak Program Operation

The program Status view provides all information regarding the operation of the current program. When a
program is first started, EZT-430i automatically directs the user to this screen to observe program operation.
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Status Cycles
On 1

Step Time Time Remaining

1 1.00 0.43

LOOP 1 5P LOOP 2 SP
ramp down to 10.0 ramp down to 30.0

The Status field indicates the current operating mode of the program, i.e., On, In Hold and Off.

The Cycles field indicates the number of cycles left to be completed for the current jump loop.

The Steps field indicates the total number of steps in the current program.

The Step field indicates the step number currently being executed.

The Time field indicates the total length of time programmed for the current step.

Time Remaining is the time remaining in the current step.

The set point for each loop indicates the programmed set point for the loop that will be achieved by the end
of the step. The fields will indicate the current ramp or soak status for the loop based on the set point of the
step. If the target set point of the step is greater than the loop set point, “ramp up to” will be displayed. If the
set point is lower than the current loop set point, “ramping down to” will be displayed. If the step is a soak
step or the target set point is the same as the current loop set point, “soak at” will be displayed.

The name of the running program, or current program loaded to the EZT-430i loop controls, will be shown at

the bottom center of the screen. If no program has been loaded, the field will be empty.

NOTE: If the first step of the running program was programmed as a soak step, the target set point shown
during the first step will not indicate the correct set point. It is recommended that all programs be
entered with the first step as a ramp step so that the target set point will be indicated correctly to
avoid operator confusion.
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6 Security

The EZT-430i security model provides an administrator with the tools to add up to 30 users to the system.
Each user must have a unique ID, full name and password. Four user levels are provided which include
system, user, supervisor and administrator levels. Specific access rights can be assigned to each user level
and password aging can be implemented. Verification is provided (if enabled) for any parameters that will
change a control parameter, which could upset the process (i.e. loop set point, start/stop automated
ramp/soak programs, etc).

Verification requires that the logged in user must log in again before the process value (at the controller) will
actually be changed. This feature is provided for extra security. The following example will make re-
authentication clearer:

A supervisor logs on the system. The supervisor then steps away from the system to take a phone call but
does not log out before leaving. If another user tries to change the control set point on any loop, the system
will require another login (by an authorized user for that level) before the control set point is actually changed.
This provides an extra level of protection to make the system more “tamper proof”.

The ‘Security’ menu, accessed from the home menu, provides access to the security section of EZT-430i.

Configure

Login
Log Off

Audit
User

Password

The ‘Security’ menu provides the following functions:

Configure: Provides access to security setup to add users, set rights and options.
Login: Log on a user if security is enabled.

Log Off Log off a user if security is enabled.

Audit: Allows the user to view any of the saved audit trail files.

User: Shows the current user logged into the system.

Password: Allows the current user to change their password.
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6.1 Adding Users

The “New” user tab provides the ability to add up to 30 users to the system. Select the type of user from the
drop down list (System, User, Supervisor or Administrator). Press each field to add the user ID, full name and
password (no spaces allowed, 5 character minimum and 16 characters maximum). Press the “Create” button
to add the user to the system. If the passwords do not match or the user ID is already used, EZT-430i will

alert the user and not accept the entry.

Ueer Type

User ID Mame

MLAMBERT MARK LAMBERT

Password Confirm Password

6.2 Viewing Users

The “Users” tab provides the administrator with the ability to view information on each user entered into the
system. Password information is not available. The user can be deleted from this tab and a new password
for each user can also be entered from this area.

New Users lAccess | options |

MARK LAMBERT (MLAMBERT)
Lisgr
Updated On: 1/17/2013

GROSSMORE (GROSSMORE)
Adrninistrator
Updated On: 1172013

To delete a user, select the user from the list and press the “Delete” button. Likewise, to change the
password for a user, select the user from the list and press the “Password” button.
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6.2.1 New Password Entry

To change a password, select the desired user by touching the User ID in the list box and press the ‘New
Password’ button. Enter the new password and confirm the password. Press the ‘Accept’ button to change
the password (no spaces allowed, 4 character minimum and 16 characters maximum).

Password ]

MNew Password

I

Confirm Password

]

6.3 Setting User Access

The “Access” tab provides the administrator the ability to assign rights to each user level (System, User,
Supervisor and Administrator). To enable or disable specific program functions (user rights) for each user
level, select the user right from the list and press the corresponding on/off button for the user level you want
to change access rights for. If the button is set to on, user access will be enabled for the user group.

New |Users Access letions |

Setpoint Edit
User Supervisor Adrinistrator

Events
Systern User Supervisor Administrator

Manual Mode

Systern User Supervisor Administrator

Administrator

Supervisor

System

User access for “Security” cannot be disabled for the administrator group. This is a safety feature to make
sure that any administrator with the proper user ID and password can access security. If the administrator
losses his/her ID or password, there is no “back door” to the system and it will have to be reset and
reprogrammed in order to return to normal operation.
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6.3.1 Security System User Access

Shown below is a list of the available user rights, where to find the menu item(s) applicable to the user right
and a description of what it applies to. Note that the OEM configuration allows many menu items to be

disabled; in which case the menu for a specific user right may not be shown.

User Right

Menu Location

Description

Setpoint Edit

View/Single, Dual loop views

applies to loop controls when not running an automatic
ramp/soak program (does not apply to loop alarms)

Events View/Events applies to enable or disable manual events
Manual Mode View/Single enable or disable loop control Manual mode button
Automatic Tune View/Single enable or disable loop control Automatic Tune button

Program Operate

Program/Run, Hold, Stop actions

applies to all program control menu selections; does not
affect digital Inputs configured for same action

Recovery

Device/Settings/Offline/Set/Recovery

logic when running an automated ramp/soak program
when power lost & recovery:

Reset Alarms View/Alarm alarm Reset button

Clear Alarms View/Alarm; Clear button prevents alarm list view from being cleared

Chart Settings View/Chart configure plot channels, scale & time for charts

Data Data/Data applies to all data logging actions & settings

Annotation Data/View/Annotation access to add operator messages to active log file

Signature Data/View/Signature access to add digital signature to active historical data file

Open see description alarm, automatic program, audit & data files

Save see description program “save” and “save as”; note files may be copied
from system with USB file transfer utilities

Delete see description data files & automatic programs; note files may be

deleted with File Utilities

Program Edit

Program/Entry

no data entry or access to Events or Step SP/Time fields;
can't insert/delete/copy/paste step.

USB Data/Utilities/lUSB allows USB memory stick to copy/delete data, alarm,
program & audit trail files & to import programs

FTP/WAN Data/Utilities/FTP/WAN configure FTP client settings

Communications Device/Settings/Set/Comms configure web page, Modbus address & VNC settings

Tuning Device/Settings/View/Tuning manual adjustment of loop tuning parameters

Setpoint Limits

Device/Settings/Set/Limit

applies to loop controls (does not apply to loop/monitor
alarms)

Adjust Alarms

Device/Settings/Set/Alarm

applies to all loop and monitor point alarms

Event Names

Device/Settings/Set/Event

configure event tagnames (seen in manual Events &
program step Events)

Email Settings

Device/Settings/Email/Email Settings

configure email settings and addresses

Email Message

Device/Settings/Email/Message

access to compose & send email message

Offline

Device/Settings/Offline

access to Off-Line menu system: Units, set Clock,
Calibrate Touch, Language, Exit To Application, input
Offset, Configuration

Calibrate Touch

Device/Settings/Offline/System/Display

access to the touch screen calibration utility

Backlight

Device/Settings/Offline/System/Display

access to edit backlight settings for brightness and off
delay time

Alarm Volume

Device/Settings/Offline/System/Display

allows edit of EZT-430i alarm beeper volume

Units Device/Settings//Offline/Set/Units loop/monitor point temperature units configuration - C\F
Clock Device/Settings/Offline/Set/Clock Set Date/Time, Time Zone, DST and NTS connection
NTP Device/Settings/Offline/Set/Clock enable & choose National Time Server location
Daylight Savings Device/Settings/Offline/Set/Clock enable Daylight Savings Time (DST)

Language Device/Settings/Offline/Set/Language Select help language

Security View/Security/Configure applies to Security Setup

Configuration Device/Settings/Offline/System/ access to import/export setup files of EZT-430i

Configuration
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User Right Menu Location Description
Default Configuration Device/Settings/Offline/System/ function to clear system configuration and reset all to
Configuration; Reset Default blank (default) state for reconfiguring
Configuration button
Exit (run mode) Device/Settings /Offline/System/Exit; prevents EZT-430i application from being stopped

“Exit application. (automatic mode
startup).” button

Exit to Configurator Device/Settings /Offline/System/Exit; prevents EZT-430i application from being stopped and
“Exit Application. (configuration mode access to the EZT-430i configurator application
startup).” button

6.4 Setting Security Options

The security “Options” tab provides the administrator the ability to set the global security options.

Password Aging Days

Verification
Audit

Security

The Password Aging Days field is a global for all users. Password aging starts from the day the user is
entered into the system. The value can be set from 0 to 365 days. A value of zero disables password aging.

NOTE: When using password aging and the password expires for a user, the user will be required to

change their password before access to the system is permitted. A user can change their password
at any time (even if aging is not used) by selecting “Password” from the main security menu.

When enabled, Verification requires that the logged in user must log in again before the process value will
actually be changed.

Audit is a global setting that turns the audit trail on or off. When the audit trail is turned on, all user actions
are written to a daily log.

Security is the global setting that turns the EZT-430i security system on or off. The security system must be
enabled for the audit trail to be enabled.
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6.5 Audit Trail

The audit trail viewer is accessed by selecting “Audit” from the Security menu. It displays all user actions that
affected the system for any given day. EZT-430i can store daily audit files for a period of a year or longer
(time based on storage usage for data history). Each time a user take an action that affect the operation of
the system (changing a set point, start/stop data logging, changes an alarm set point, etc.), the action is
written to a file. Audit trail file names are listed as month_day_year. The “Open” file button will display a
dialog box where the user can select any audit file to view.

NOTE: If no actions occurred on a given day, an audit file will not be created for that day.

4/23/2013
| 4:54 PM

Audit File ’X.‘ Open

Interval (secs) From 60 To 2
Device Manager

1/17j2013 107 PM

Data file start
Device Manager

17172013 1.07 PM

Data file end
Device Manager

17172013 1.08 PM

Each action recorded to the file includes the date/time it occurred as well as the user (if logged in) that made
the change. If no user is logged in, the user will be listed as “Device Manager”, which is the default user
account for the EZT-430i system.

The send email icon =& allows the user to send a copy of the currently opened audit trail file to any user
configured in EZT-430i. When the email icon is pressed, an “Add Recipients” window will be displayed where
the user can select recipients for the file from any of the email addresses configured under the EZT-430i
email settings. For information on how to add email recipients to EZT-430i, see the section 8.9, Email.
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7 Data Logging

The EZT-430i data logging features are accessed via the home ‘Data” menu item. The system data logging
provides the ability to select individual points for logging, view data log files and start/stop logging operations.
The logging ability of EZT-430i provides an easy-to-use, convenient method to obtain electronic data without

the need for additional data acquisition equipment.

The Data Log menu provides navigation to the following functions:

= Annotation View menu
File | Signature Annotation: Allows the user to insert a notification into the currently
running log file or view all annotations associated with the
Data currently loaded historical data file.
— Signature: Allows the user to digitally sign a file to prevent data
Chart » tampering and view all digital signatures associated with the
-~ currently loaded historical data file.
Utilities »
View File menu ' ' '
- Open: Opens a history file for review.
< Open Delete: Allows the user to delete the currently loaded history file.
Data .| Delete _ )
NOTE: The “Delete” log file function does not affect data from a
Chart file that is running, only the current data log file loaded
SR for review.
Utilities »
View Data menu
- Data: Displays main data log screen with status of logger.
File Assign: Allows the user to select what variables are to be logged.
Data Data
Chart | Assign
Utilities »
View Chart menu
Set: Selection of data file points and time period for history review.
File 5 Chart: Plots historical data after time and points are selected.
Data
a Set
Utilities »| Chart
View Utilities menu
— USB: Allows the user to access file utility functions.
File  » FTP/WAN: Provides access to the automatic file back-up settings.
Data > Memory: Displays memory capacity remaining on EZT-430i.
| UsB
Chart L4 FI-P/\NAN

nﬂﬂﬁ Memory

Logging
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7.1 Selecting Points for Logging

In order for the data logging function of EZT-430i to operate, you must first select what variables are to be
logged to the data file. To choose which points are to be logged, select “Assign” from the Data menu. This
screen allows the user to select any point(s) from the system for data logging.

4/23/2013
| 4:59 PM

Assign Save |

_on | LOOP 1 PV
| on | LOOP 1 SP

| on | LOOP 1 %0ut

OFF LOQP 2 PV

Select the desired items from the list by turning each one on or off. When selections are completed, press the

“Save” button to save the point selection to memory. New selections will not take effect until the Save button
is pressed.

7.2 Starting/Stopping Data Logging

EZT-430i logs data to its SD card. Current data for each variable is written to the log at a fixed interval based
on the settings entered in the “Length” and “Interval” fields. File names are automatically generated using
mm_dd_yyyy hh_mm_ss format. To enter a new alphanumeric file name, touch the “File Name” field and

enter the desired value (up to 16 characters each). When a file name is specified, the file will be saved as
FileName_mm_dd_yyyy hh_mm_ss.

4/23/2013
| 4:59 PM

Length{days) Interval {secs)

Start Program Fized Interval

OFF OFF .on B

The data logger also provides two entry fields, ID#1 and ID#2, which allow the user to enter in information
specific to the file such as a batch and/or lot number to identify product that may be associated with the new
data file. These entries will be saved with the data log file for later identification.
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The Length (days) field sets the length of a data file in number of days. It can be set for 1 to 31 days. Once
the selected number of days has elapsed, a new data file will be created and logging will continue in the new
file.

The Interval (secs) field is used to set the rate at which points are written to the log file which equates to the
sample rate in seconds. When the “Fixed Interval” option is turned on, the logging interval will be
automatically set to record at minute intervals based on the number of days set for the file. If the file is set for
1 day in length, the logging rate will be at 1 minute intervals. If the file is set for 7 days, then the logging rate
will be every 7 minutes. This keeps the data file size manageable and able to be viewed by the EZT-430i
data viewer.

The log interval can be manually set to any rate between 2 and 1860 seconds in any combination with the
number of days before a new file is started. To do this, turn off the “Fixed Interval” option and enter in the
desired logging rate in seconds.

NOTE: Logging at shorter intervals allows EZT-430i to capture fast changing processes, but the data files
can become extremely large. Files that exceed the capability of the EZT-430i data viewer (>520KB in
size) will have to be extracted from EZT-430i using a USB memory stick or FTP file transfer in order
to be viewed remotely on a PC.

Files larger than the 520KB limit will not be automatically, digitally signed by EZT-430i. If the files are
to be digitally signed, this must be done manually by extracting the files and using the CSZ data
viewer program running on a remote PC.

To manually start data logging, press the “Data” button. Any time logging is enabled, the indicator on the
Data button will be illuminated. To stop data logging, press the Data button again. Data logging can also be
started automatically by turning on the “Start” or “Program” option.

The Start option automatically turns data logging on whenever EZT-430i is first powered on. This action
simulates that of a standard chart recorder.

The Program option is a convenient method for gathering information that pertains only to the operation of an
automated ramp/soak program. When selected, EZT-430i will turn the data logger on at the beginning of a
program and off once the program is completed. This eliminates the need to scan through extensive data
records to find the specific information you are looking for from a particular time period.

NOTE: EZT-430i will automatically use the program name as the filename for the log file. This provides a
simple identifier for log files that pertain only to an automatic program operation. Any entry made in
the File Name field will be ignored.

7.2.1 Calculating Log File Size

EZT-430i saves the log file in a text based format (.csv), so the amount of memory consumed for each
reading is dependent upon the number of digits required to accurately display the value. This optimizes
memory usage but also makes calculating an exact file size difficult. To obtain a worst case approximation of
the resultant file size, use the following formula:

File Size (KB) = 1 + [0.023 + (0.006 * number of log points)] * number of readings

7.3 Reviewing Historical Data

Historical files can be opened and viewed using the historical viewer. In order to view a historical data file, it
must first be opened by selecting “Open” from the File menu. Once the file has been opened, EZT-430i will

Logging EZT-430i REVC 7.3



EZT-430i1 User’'s Manual Cincinnati Sub-Zero

automatically plot the first eight channels of the historical data file or the user can choose to cancel the plot
select which channels should be plotted as well as adjust the specific time period to plot.

7.3.1 History Plot Setup

The history plot setup allows the user to select any time frame (zoom in/out) from the historical data file as
well as select up to six channels of data to plot. To edit the settings for the historical plot, select “Set” from
the Chart menu.

4/23/2013
- 4:59 PM

Chart Settings
| on | LOOP 1 PV
| on | LOOP 1 SP

| on | LOOP 1 %0ut

Axis Left Right
.on B OFF

Any point from the data file can be selected along with the vertical axis to be used for each channel to be
plotted. Select channels from the list by turning them on or off, and use the “Left” and “Right” axis buttons to
assign the selected item to the left or right axis for the plot range. To adjust the period of time to plot from the
data file, press the “Time” button.

Select a button on the screen.

File (start/ end) Return |

File Date Start
1/17/2013 1:07:24 PM

File Date End
1/17/2013 7:08:12 PM

='

The start and end dates for the currently loaded file will be shown with time in hours, minutes and seconds.
The “File Date Start” and “File Date End” sliders are used to select a time span for historical viewing. Once
the desired start and end times have been set, press the “Return” button to return to the Chart Settings
screen.

7.3.2 Plotting Historical Data

The history Chart plots the data from the currently opened history file according to the selections made under
chart setup. If a file has not been opened or data points have not been assigned to a plot, EZT-430i will alert
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the user to correct the problem. The ‘X’ and 'Y’ axis scales are set to auto scale based on current values for
each plot channel so no user action is required.

The historical graph provides the same zoom feature as the real-time charts so the user can zoom in on a
particular area of the historical plot by dragging their finger across the screen to draw a rectangle around the

desired plot area.
Select a button on the screen.

Chart Legend | Return |

Start: 4,/28/2012 - End: 4/28/2012

107.8
89.0
70.2
51.5
32.7
13.9
04/28 10:05PM 04/28 10:08PM 04/28 10:11PM

Pressing the “Legend” button will provide the user with channel information by displaying the names of the
selected plot channels, which axis they are associated with and the color used to display the plot channel.
Pressing the button again will toggle the display back to the historical chart.

Select a button on the screen.

C ha It Legend | Return |

LOOP 1 PV LOOP 2 5P
Left Axis Left Axis
LOOP 1 5P
Left Axis

LODP 1 2o0ut
Left Axis

LOOP 2 PY
Left Axis

NOTE: When pressing the Legend button to toggle between the historical chart and the legend screen, it
may take several seconds for the chart to become visible depending on the size of the data file and
number of channels selected to plot.

When finished viewing the historical chart, you must press the “Return” button to exit the historical
data viewer and return to the main data log screen.
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7.4 USB File Transfer

A quick note about file storage; data and setup files (programs, alarm log and audit trail files) need some
maintenance every now and then. After a period of time, storage devices fill up and files require backup or
file deletion when no longer needed. The “Utilities” section of the EZT-430i interface provides all the
functionality required for maintaining the internal SD memory card. The internal SD card should not be
removed from the EZT-430i interface. Any change to SD directory structure (moving or deleting files with a
PC) may cause the EZT-430i interface to stop operating and a new SD card will need to be ordered. Never
move or delete the directories unless using the provided EZT-430i file utilities functions.

NOTE: The data log files, programs, alarm log and audit trail directories are saved to the internal SD card
(not the USB memory stick device) plugged into the EZT-430i interface. Never unplug the SD card
when EZT-430i is powered up or loss of data may result.

The USB file transfer screen allows the user to copy or erase files from the internal SD card. Complete file
directories for all EZT-430i file types can be copied to the USB memory stick and erased from the internal SD
card. The current status for file functions is displayed for the operator during copy/delete operations. EZT-
430i also allows automatic programs to be imported from the USB memory stick. Programs must be exported
from another EZT-430i device to the memory stick first, before this function can be used. EZT-430i will look
for “Program” directories on the memory stick for import and alert the user if none exist.

NOTE: Allfile transfer functions can be used while data logging is running. If the operator needs to back up
or delete files from the system, a large number of files could take considerable time to backup and
delete from memory. The file transfer screen will be locked during file transfer so plan the timing
appropriately when access to other screen functions is not required. When data logging is running,
the current data log file will not be copied or deleted while using the file transfer functions. This
protects the current file and makes sure that the data file is complete before being copied and
cannot be deleted from memory while it is still in operation.

4/23/2013
9 PM

Copy/Delete
Import

MWote: Memory stick must be inserted for file transfer

To Copy files, insert the USB memory stick into the USB port. Select the file type you wish to copy from the
“Export Type” drop down menu. Available file selections are Program, Alarm, Audit and Data files. Once the
selection is made, press the “Copy” button. All related files will be copied to the USB memory stick with
progress status displayed to user.
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To Copy/Delete files from internal memory, insert the USB memory stick into the USB port. Select the file
type you wish to copy and erase from EZT-430i’ internal memory, by selecting it from the “Export Type” drop
down menu. Available file selections are Program files, Alarm files, Audit trail files and Data files. Once the
selection is made, press the “Copy/Delete” button. All related files will be copied to the USB memory stick
and then deleted from EZT-430i with progress status displayed to user.

The Import file function allows automatic ramp/soak program files to be copied from the USB memory device
to EZT-430i. A dialog box will appear listing the available program directories on the USB memory stick.
Program directory names exported from EZT-430i are in the format ‘Programs_mm_dd_yyyy-hh_mm_ss’.

NOTE: The USB memory stick must be inserted into the USB port for any of the file utility operations to
function. It is recommended to only use memory sticks certified by CSZ Controls for use with EZT-
430i. CSZ Controls has tested and validated these memory devices for proper operation and
performance.

Due to manufacturing variations in the USB memory sticks, it may take from a few seconds up to 30
seconds for EZT-430i to recognize the device when it is plugged in. Allow sufficient time for the
device to be recognized before attempting any file utility operations or EZT-430i will indicate a file
transfer/memory stick error.

When files are being copied to the USB storage device, a directory for each file type will be created to store
the copied files. The directory structure is as follows:

Program files directory: Programs_mm_dd_yyyy-hh_mm_ss

Alarm files directory: Alarm Files_mm_dd_yyyy-hh_mm_ss
Audit files directory: Audit Files_mm_dd_yyyy-hh_mm_ss
Data files directory Data Files_mm_dd_yyyy-hh_mm_ss

The purpose for using the date and time as part of the directory name, is to make sure the user can track the
date and time of the file transfer. If a user transfers a file type more than once in a single day, the files will be
grouped logically by time.

When accessing the data files saved to the USB memory stick, the data files will be in “.csv” format. These
files can be opened directly with Microsoft Excel or any program that opens a comma separated file format.
You can copy or empty the “Data Files™ directory by simply plugging the USB device into a PC’s USB port.
The device then becomes like any removable disk attached to the computer and can be manipulated once
plugged into the PC.

The CSZ Data Viewer program is a free Windows accessory program that allows users to view, plot and print
data files and is available from CSZ Controls or any manufacturer that markets the EZT-430i product. It is
required when using the digital signature feature of EZT-430i.

IMPORTANT: Once files are deleted from EZT-430i storage devices, they are gone and cannot be
retrieved. Once again, do not edit, move or delete any other files from the internal SD
memory card unless using the EZT-430i file utilities. EZT-430i may not operate properly if
you do so.

‘Windows XP’ and ‘Excel’ are trademarks of the Microsoft Corporation.
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7.5 FTP Data Backup

The FTP/WAN screen allows the user to configure automatic back-up of all data files contained in EZT-430i’
memory to a user designated FTP site. When enabled, EZT-430i will automatically back up all data log files,
alarm files and audit trail files at 2:00AM each day. With the optional delete files selection, EZT-430i will then
automatically delete the files from its internal memory after back up. This will maintain EZT-430i" memory
automatically, so that continuous data logging can be performed without filling up the available memory
space.

NOTE: Setting up an FTP site on your network may require authorization and/or assistance from your
network administrator. Contact your network administrator for proper settings and authorization from
your network server (if required) to allow EZT-430i to connect to the designated FTP site.

FTP l WAN Start | Save |

IP Add 192.168.0.102
Vser[ PR ]

Server FTP Data Files

user Name', Pswd blank for anonymous logins

Automatic Transfer Delete internal files when

OFF (Z:00AM) OFF done

The IP Add field is used to enter the IP address of the FTP site that EZT-430i is to send the files to.

The User field allows you to enter a user name for FTP site access. When EZT-430i connects to the FTP site
to transfer files, the user name will be used to identify the connection. If a security login is required, the
proper user name will have to be entered in this field. If security is not used, this field can be left blank.

The PSWRD (password) field is used in conjunction with the user name field and is for entering a password, if
required by your FTP site, so that EZT-430i can access the site. If security is not used, this field can be left
blank.

The Server field is used to enter the server directory where the files are to be backed up. When the
automatic back-up occurs, EZT-430i will place the historical data files in this directory on the FTP site. EZT-
430i will automatically create an ‘Alarms’ directory and an ‘Audit’ directory within the specified server directory
for backup of the alarm files and audit trail files.

When the Automatic Transfer (2:00AM) option is turned on, EZT-430i will perform an automatic backup of
all historical data files, alarm files and audit trail files contained in its internal memory to the designated FTP
site. Note that if data logging is currently active, the active file will not be copied.

When the Delete internal files when done option is turned on, EZT-430i will delete all data log files, alarm

files and audit trail files within its memory after completing the backup to the FTP site. Note that if data
logging is currently active, the active file will not be deleted.
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Once all settings have been made, press the “Save” button to save the settings so that on the next power-up,
the entries will be maintained. The “Start” button can be used at any time to perform a manual data backup.
If the files already exist on the FTP site, they will be overwritten on each subsequent backup. If the FTP site
is down, or EZT-430i is not connected to the network, a local alarm message on the Alarm screen will indicate
a transmission failure.

NOTE: Typically FTP Server software uses case sensitive alpha-numeric characters for the User name,
Password and Server directory. Contact your network administrator for proper settings.

7.6 Annotation

The Annotation screen allows the user to add a messages to the running data file and view any messages
currently associated with a loaded historical data file.

4/23/2013
| 4:59 PM

Annotation Save

REMOVE BATCH 567
1j17/2013  1:58 PM
User: MARE LAMBERT
ADD BATCH 568
1/17/2013  1:59 PM
User: MARK LAMBERT

When a historical data file is loaded, the Annotation screen will display any messages that were written to the
file. The date, time, user name and description of the data file annotation is shown. Note that the currently
running data log file can be opened as a historical data file, and the current annotations for the running file will
be shown.

To add an annotation to the running log file, touch the “Entry” field at the bottom of the screen and enter the
message (up to 16 characters maximum). Press the “Add” button and the message will be added to the
current log file. If the running log file was opened as the historical log file, the annotation will be shown
immediately on the screen as it is added. If logging is not currently running, the entry field will be disabled.
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7.7 Add\View Digital Signatures

The Signature screen allows the user to add digital signatures to historical data log files and view any digital
signatures currently associated with the loaded historical log file.

4/23/2013
g 4:59 PM

Signature Verify Save

Data file is not active
1f17/2013 203 PM
User: Device Manager

When a historical data file is loaded, the Signature screen will display any signatures currently associated with
the file. To verify a digital signature and insure that the data file has not been altered, touch the signature in
the list box and press the “Verify” button. EZT-430i will compare the signature to the log file to see if any
alterations to the data have been made. EZT-430i will then indicate if the signature is valid or not.

If the signature is valid, the historical data file is intact and has not been altered. If the signature is invalid, the
data has been altered at some time after the signature was assigned to the file. For data integrity, EZT-430i
automatically signs a data file when logging is stopped; however, this only occurs if the “Auto Interval” is
selected on the Log screen. If a different logging interval is used, EZT-430i will not automatically sign the file,
and it must be signed by a user.

To add a digital signature to the historical log file, touch the “Entry” field at the bottom of the screen and enter
in the comment line for the signature (up to 16 characters maximum). Press the “Add” button and the
signature will be added to the log file. The signature includes the date and time of the signature, the user
name and comment line. If a user is not logged into the system, the default user name “Device Manager” will
be used as the user.

NOTE: The Signature screen is not available if security is disabled. The EZT-430i security module must be
enabled in order to digitally sign data log files. See Section 6, Security.
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8 Device Settings

This section covers the use of extended controller features that enhance the functionality of your system. To
gain access to the EZT-430i setup options, select ‘System Setup’ from the home Setup menu.

The System Setup menu provides navigation to the following functions:

= Tuning Vievy menu _ .
Tuning: Provides access to manual loop tuning.
Set 3
Email »
Offline »
- Setup menu
View Alarm: Provides access to the alarm set points/message entry.
e A\ arm Limit: Sets minimum/maximum set points allowed for each loop.
= Event: Allows the user to edit names used to describe events.
— | Limit Navigation: Allows the user to choose text based or icon based/slide
Email » page navigation menus.
— | Event comms: Allows user to set EZT-430i communication settings.
Offline | Navigation
Comms
View Email menu
Email; Provides access to the EZT-430i email system manager.
Set . Message: Allows the user to send an email message to users
entered in the system.
3 Email
Offline»| Message
View » Offline menu
Offline: Provides access to offline system settings.
Set
Email »
oliiihCHY Offline
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8.1 Tuning

The loop Tuning screen allows for manual tuning of the EZT-430i control loops. Tuning parameters should
only be adjusted by skilled users familiar with proportional control. Improper settings can result in control loop
instability and equipment damage. The loop automatic tune function is the recommended method of loop
tuning. If the control response achieved after performing an auto tune does not provide the desired control
response, then minor adjustment of the tuning parameters may be done to obtain the desired response.

HOA iew
LOOP 1 Tuning E—

P¥Y = 29.3C SP = 30.0C

Prop Band

TI (secs) 100

TD (secs)

Cooling PB: 100

Dead Band

The available tuning parameters are dependent upon the loop configuration. If programmed for heat or cool
only control, then the available parameters will be PB (proportional band), Tl (integral time period) and TD
(derivative time period). If the loop is configured for heat/cool operation then two additional parameters for
Cooling PB (cooling proportional band) and Dead Band (heat/cool dead band) will be provided.

The tune screen also provides a live real time chart for monitoring the control response of the control loop
while adjusting tuning parameters. The chart is fixed at a 10 minute time period and updates once per
second. Pressing the Set button allows the user to adjust the loop set point without having to leave the tuning
screen in order to observe the control response.

Heat or Cool only P (or PD) Control

When a loop is programmed for heat or cool only control, it is possible to set the integral time to zero in order
to eliminate reset action. A “PB Offset” field will then be shown for entering a manual reset value to correct
for the control offset that will occur once the loop has stabilized. The offset entry is measured in percent with
a range of 0-100%.

Once the process has stabilized, if the process value is lower than the set point by 5° for example, and 20.0 is
used for the proportional band, that is equal to an offset of 25%. Thus, the PB offset would be increased by
25% to compensate for the set point offset in the process. Note that automatic tune is disabled for P or PD
control. In order to perform an auto tune, the integral time would have to be set to a value greater than 0. P
or PD control is not precise for processes with changing load conditions and will require frequent adjustments
of the offset. The PID control mode should be used because it automatically does this for you.

Heat/Cool (Bimodal) Control
When a loop is programmed for heat/cool operation, the values of the Cooling PB and Dead Band affect the
way the heat and cool outputs work together to control the process.

The Cooling PB is measured in % of the proportional band with a range 50-300. Set cooling PB to 100% to
begin and examine the cooling effect. If cooling action should be enhanced then decrease the band. If
cooling action is too strong then increase the cooling band. The value of the cooling proportional band is
related to the heating PB and its value remains unchanged throughout any auto tuning procedures.
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NOTE: The adjustment of CPB is also related to the cooling media used. When air is used as the cooling
media, it is recommended that the Cooling PB be set to 100%. For oil, a typical setting to use for
the Cooling PB is 125%. If water is used as the cooling media then adjust the Cooling PB to 250%.

The adjustment of Dead Band is more dependent upon system requirements. If more positive values of dead
band (greater dead band) are used, an unwanted cooling action can be avoided but an excessive overshoot
may occur. If more negative values of dead band (greater overlap) are used, an excessive overshoot can be
minimized but an unwanted cooling action may occur.

Dead band is adjustable in the range of -36.0% to 36.0 % of the heating PB. A negative dead band value
provides an overlap between heating and cooling in which both outputs are active. A positive dead band
value provides a dead band area in which neither output is active around set point.

8.2 Alarms

The alarm screen allows the user to edit the alarm set points and alarm messages that will be displayed on
the alarm screen should the alarm be activated.

NOTE: The EZT-430i loop controls can provide up to 3 alarm outputs each (for a total of 6 alarms).
Depending upon the configuration of EZT-430i, some outputs may perform specific control or event
functions.

4/23/2013 ‘ *
5:04 PM

Alarm Settings

Alarm #1 LOOP 1 Process HighSP [ 40.0 ]

Alarm
Message ALME1

Alarm 82 LOOP 2 Process Low SP 10.0

Alarm
Message ALME2

The alarm numbers, Alarm #, identify the alarms currently shown on the screen. The left and right scroll
buttons at the upper right of the screen will be shown if more than two alarms are available so that the user
can access each alarm by pressing left or right to go to the previous or next alarm.

The alarm SP (set point) description displays the loop name that the alarm is assigned to as well as the alarm
type. The alarm type and alarm hysteresis cannot be changed. Only the alarm set point can be changed by
the user.

The Alarm Message is the text notification that appears on the Alarm screen when the alarm activates. This

message can be edited (up to 25 characters maximum) so that the alarm message more accurately describes
what the alarm means.
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8.3 Setpoint Limits

The set point Limits screen allows for the adjustment of the minimum and maximum operating set points
allowed to be entered for the control loops. These limits can be used to prevent operators from entering a
value that exceeds the survivability limits of equipment or product being manufactured, reducing the risk of

property damage.

4/23/2013 « »
5:04 PM

Setpoint Limits
LOOP 1 (C)

Lower Limit

Upper Limit

Enter the desired set point limits by touching the “Lower Limit” and “Upper Limit” entry fields and enter the
desired values using the numeric keypad.

8.4 EZT-430i REVC Device Settings



EZT-430i User’'s Manual Cincinnati Sub-Zero

8.4 Event Names

The Event Names screen allows the user to change the names of the system events in order to describe what
function they perform. The event names are limited to nine alphanumeric characters.

4/23/2013
g 5:04 PM

Event Names Edit |
EV1i
EV2

To change the name of the event, select the event by touching its current tag name in the list. Press the
“Edit” button and enter the new tag name using the alpha-numeric keypad and press “Done” when finished.
The new name will then appear in the event name list box and will be used throughout all EZT-430i screens
wherever the event is shown.

8.5 Navigation

EZT-430i provides both text based PC style menus and icon based/slide page navigation menus similar to
today’s “smart” devices. The user can select either type at any time from the Navigation screen.

Navigation

| Menu Navigation

[ Icon Mavigation

Press the button for the desired menu type to make the selection. The choices are mutually exclusive, so
when one selection is made, the other will be de-selected. The button indicator for the active selection will
illuminate to show the current selection.
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8.6 Communication Settings

The “Comms” screen provides settings for the Modbus serial interface, web server and VNC interfaces. It
also provides the EZT-430i IP address, which is required for using the VNC or web server interfaces.

Modbus Address

VNG Address Pswrd

None

None
VYNC Password * *
IP Address 192.168.0.6

[ ; [

The Modbus Address and Parity settings are used to configure the serial interface for user communications.
Valid addresses are 1 to 31. The parity setting is only available for the standard EZT-430i LC interface and
allows the serial port to be set for Even, Odd or no parity (None). If EZT-430i is configured to provide the
simulated Watlow F4S/D communications interface, the parity selection will not be shown.

The VNC Address and Password set access rights to the EZT-430i VNC server. Valid addresses are from 0
to 255. The VNC password selection defines the connection mode for the server. The selections are “None”
and “VncAuth” which requires users to enter the password when connecting to EZT-430i over the VNC
interface.

IMPORTANT: When multiple EZT-430i controllers are connected to a single router (DHCP server), it is
imperative that each EZT-430i have a different VNC address. If multiple EZT-430i controllers
have the same VNC address, network errors may result causing the VNC server to shut
down or cause EZT-430i to “lock-up” and become non-responsive requiring the unit to be
power cycled in order to return to normal operation.

The VNC Device Name field is used to enter a name (up to 35 characters) that can better identify EZT-430i to
users logged into the VNC interface. The name entered here will be used on the VNC header window on a
PC, so that if multiple VNC clients are open to different systems, each one can be identified.

The VNC Password field is used to enter the password (up to 20 characters) that a user must enter for the
VNC interface to connect to EZT-430i if the VNC password is enabled.

The Www. (web server) pushbutton is used to enable or disable the web server interface.

The VNC server pushbutton is used to enable or disable the VNC server interface.

The IP Address field is a static field that provides the IP address of EZT-430i which is required for connecting
over the VNC and web server interfaces. For more information on Device IP and other LAN information refer
to Section 10, Communications.

NOTE: Any changes made to the above settings must be saved in order for them to take effect. When

changes are completed, press the ‘Save’ button, and then cycle power to EZT-430i. The new
settings will only take affect when EZT-430i first boots up.
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8.7 Emalil

The EZT-430i email server has the ability to send alarm messages to email and SMS addresses. Up to 30
addresses can be programmed into the system. Each one can be configured to receive emails, SMS text
messages or both. When an alarm occurs, EZT-430i will send an alert to the specified address for each user
in the list. The email settings are accessed by selecting “Email” from the setup “Email” menu.

8.7.1 Email Address Entry

Select the “New” tab to add new email addresses to the system. For each entry, enter the recipient’'s Name,
Email Address and/or SMS Number (up to 50 characters each). Turn on the Email Alarm and/or SMS Alarm
options to specify which addresses the alarm messages are to be sent to. Press the “Create” button to add

the user to the list.
4/23/2013
= 5:04 PM

New | Addresses | Settings

MName SMS Number

Bill Smith 0123456789@phone.com

Email Address smith@mycompany

Email Alarm M SMS Alarm

NOTE: The SMS address is specific to the service provider. Each service provider has their own unique
address; however, the phone number is always the “name” for the address entry. Below are common
examples for some of the more common cell phone providers. There are internet sites with this
information that cover most of the providers, or when in doubt, contact your service provider for the
proper address format.

Cell Phone Provider Maximum message length SIS AGITESS 0 use e Sl
example for a 10 digit cell phone number)

Cingular 150 characters 0123456789@mobile.mycingular.com

Cingular (GSM) 0123456789@cingularme.com

Cingular (TDMA) 0123456789@mmode.com

Nextel (now part of Sprint Nextel) 140 characters 0123456789@messaging.nextel.com

Sprint 0123456789@sprintpaging.com

Sprint PCS (now Sprint Nextel) 160 characters 0123456789@messaging.sprintpcs.com

T-Mobile 140 characters 0123456789@tmomail.net

Verizon 160 characters 0123456789@vtext.com

Verizon PCS 0123456789@myvzw.com
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8.7.2 Email Addresses

Selecting the “Addresses” tab allows the user to view the list of email addresses entered in EZT-430i. Each
entry will be shown with the notification method and address associated with it (email/SMS). To delete a
user, touch the name of the user in the list box and press the “Delete” button. This will permanently remove

the user from the list.
4/23/2013
5:04 PM

Bill Smith
Ernaill On alarm, smithi@rmy conpany, com
SMS O Alarrn: 0123456789 @phone, com

8.7.3 Email Settings

The “Settings” tab provides access to the email server configuration, which is how EZT-430i is able to connect
and send email messages over its Ethernet connection. Each field may have up to 50 characters.

4/23/2013
5:04 PM

New | Addrresses Settings
Login Return Address

nl::Drnpas.g[@n-l?[un-lpan?.EDIT'

Password SMTP Address

rnail[ﬁlr“vcur“pan?

Subject nCompass Alarm Message

The Login field is used to enter the login name required by EZT-430i to log in to your company’s mail server.
You can use your login if one is not set up specifically for the EZT-430i on your network. Contact your
network administrator for assistance.

The Return Address is the address given for EZT-430i on your company’s mail server. EZT-430i does not
accept email messages; however, this field is required for proper email delivery for security/anti-spam
purposes. If using your personal login name, you can also use your personal email address if one is not set
up specifically for EZT-430i on your network. Contact your network administrator for assistance.
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The Password field is used for entering a password, if required by your network server, to send email.
Contact your system administrator for assistance.

This SMTP Address field is for entering the address of the email server used for sending emails. This must
be a valid mail server for which the above settings allow EZT-430i access. Contact your system administrator
for assistance.

This Subject field is used to enter a subject line for emails and/or SMS text messages. It can be used to
provide an identifier to the recipients of the alarm message to know which chamber it is coming from.

NOTE: It is recommended to put some form of entry in this field. It can be left blank; however, many
firewalls and spam filters will filter out messages without subject lines. That may prevent recipients
from receiving the email. It can also be useful for identifying a particular unit on the factory floor.

Once all settings have been made, be sure to press the “Save” button to begin using the new values and
store them, so that on the next power up, the settings will be retained. The body of the email/SMS text
message will contain the description of the alarm condition as it would appear on the alarm screen. If the mail
server is down, or EZT-430i is not connected to the network, the message will not be sent and a local alarm
message on the alarm screen will indicate a transmission failure.

8.7.4 Email Message

EZT-430i provides the user with the ability to send short email messages to users configured in the EZT-430i
email server. To send a message, select “Message” from the device settings, Email menu.

4/23/2013
| 5:04 PM

Email Message

Press the “Compose” button to create a brief message using the keypad (up to 100 characters). When you
are finished entering the message, press the “Done” button. The completed message will then be shown in
the message window. Press the “Send” button to select the email recipients you wish to receive the message
and send the message.
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9 Offline

Note that prior to entering offline setup, automated ramp/soak program operation and data logging must be
manually stopped.

The offline menu provides navigation to the following functions:

Set v
Calibrate »

System »

View v

Calibrate »

Recovery

Units

System »

Clock

Language

View v

Set 3

Calibrate »

System

Offset

View v

Set 8

Calibrate »

Display
Configuration
About

Exit

Offline Setup

View menu
Settings:

Set menu
Recovery:
Units:
Clock:
Language:

Calibrate menu

Offset:

System menu
Display:
Configuration:
About:

Exit:

Navigation back to the device settings menu.

Settings for profile power recovery action.
Setting for temperature units.

Settings for system date and time
Settings for menu and help language text.

Settings for loop input offset calibration.

Access to display calibration and backlight settings.
Access to EZT-430i import/export utility.

View current firmware/software version numbers.
Exit EZT-430i application and access to the
EZT-430i configurator.
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9.1 Power Recovery

The Power Recovery setting allows the user to select how the system should restart in the event of a power
failure while an automatic ramp/soak program was running. When power is restored, EZT-430i will perform
the selected recovery action. To set the power recovery action, push the recovery mode button for the
desired setting to select it as the power-up state. The selections are exclusive to one another, i.e., only one
can be selected at a time. As a new selection is made, the previous setting will be automatically turned off.

Recovery

[ Continue from SP N Continue from PV
| Static Mode

Select start mode on electrical fail.

Select Continue from SP to have EZT-430i resume the program from where it left off on loss of power. The
set point ramp will continue from the set point value at the time of power interruption.

Select Continue from PV to have EZT-430i resume the program from where it left off on loss of power. The
set point ramp will continue from the current process value of the loop and not the last set point value.

Select Static Mode to have EZT-430i default to single set point operation on power-up. The program will be
stopped and the loops will control to the last static set point entry.

NOTE: When a program is NOT running and a power down/up sequence occurs, EZT-430i will return with
the same set points and system events active as when the power was lost.
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9.2 Degrees C/F Units Selection

EZT-430i can display temperatures in either degrees Centigrade or Fahrenheit. To change the temperature
display units, select “Units” from the offline Set menu.

Units

Select units of measure for temperature
readings

[ Centigrade | Fahrenheit

Press the button for the desired temperature units to make the selection. The choices are mutually exclusive
so when one selection is made, the other will be de-selected.

NOTE: When changing display units, ramp/soak program set points will not be converted between units.
Separate programs are required for each temperature range. Operating EZT-430i with programs
that have been written using alternate units could cause property damage or personal injury.

The temperature units selection only effects control loops configured with temperature input

devices, i.e., thermocouple or RTD. The units display for loop controls with linear inputs (mA or
Vdc) will not be effected by this selection.
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9.3 Clock Settings

The system date and time is adjusted from the “Adjust Time” tab under the Set/Clock menu. The current date
and time will be displayed in the thumb wheels as shown below.

January
February

To make adjustments, scroll each time wheel to adjust the month, day, year, hour, minutes, seconds and
AM/PM selection. Once all adjustments have been made, press the “Save” button to set the system clock to
the date and time entered.

9.3.1 Time Options

Select the “Time Options” tab to configure the time zone and national time server clock settings. If EZT-430i
is connected to the internet, these settings can be used to have EZT-430i automatically synchronize its time
with one of the nationally provided time servers.

NTP Server tick.usno.navy.mil

Current Time 4 /17 /2013 2:35:27 PM

NTP Service Enabled M

To enable the national time server, select your time zone and which time server you wish to use from the drop
down menu selections. Turn on the “NTP Service Enabled” option and press the “Save” button. EZT-430i will
then synchronize its time with the selected national time server at 2:00AM each day.

If EZT-430i is not connected to the internet, a local alarm message will be shown on the alarm screen; “NTP
Ping Failed. Check Cable”, to indicate that the time server could not be located.
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9.3.2 Daylight Savings

Select the “Daylight” tab to configure daylight saving time options. The daylight savings time options allow the
user to set the start date and end date for daylight savings time.

Adjust Time I Time Options |

February | 10 [2012 October

11 |2012) November | 04 |2012
12 |2014§ December | 05 [2014

Daylight Savings Enable M ﬁ

If your locale utilizes daylight savings time, set the start and stop dates for daylight savings and turn on the
“Daylight Savings Enable” option. Press the “Save” button to store the settings. EZT-430i will then

automatically update its clock for daylight savings time.

NOTE: If the NTS time server setting is enabled, and the selected time zone uses daylight savings time,
daylight savings must be properly configured and enabled or the clock will not show the correct time.
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9.4 Language

The Language screen is used to select the language for all of the online help, menus and most static display
fields. Note that the keypad will remain in English, so all user text entry will still be in the English language.

B O &

L 4

Language Save
_oN | English
OFF  Finnish
| OFF  French
OFF | German

Available language selections include:

LA RARRARRARRRRRRRRRRRAXARN

Afrikaans
Albanian
Arabic
Basque
Belarusian
Simplified Chinese
Traditional Chinese
Czech
Danish
Dutch
English
Finnish
French
German
Greek
Hebrew
Hungarian
Icelandic
Italian
Japanese
Korean
Norwegian
Polish
Portugese
Russian
Spanish
Swedish
Turkish

DISCLAIMER: English is the default language for the EZT-430i control system. All other language selections provided through
internet translation of the English language. CSZ does not guarantee the accuracy or validity of alternative language selections
and shall not be liable for any damages or losses, whether direct, indirect, incidental, special, consequential or any other
damages for misinterpretation of other languages. CSZ offers a free, PC based application which allows the end user or OEM

to create the translation files for the desired language selection.

control system in order to provide a more accurate or desired translation for the online help files.

9.6

EZT-430i REVC

The translation files can then be copied to the EZT-430i
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9.5 Offset Calibration

Each EZT-430i loop control is calibrated at the factory before shipment; however, they can be recalibrated in
the field with the use of proper calibration equipment. While the basic calibration of the unit is highly stable
and set for life, the input offset calibration provides the means for the end user to offset the permanent factory
calibration. Typically reasons for applying this offset may include the need to match a particular reference
standard, to match the calibration to a particular transducer or sensor or to remove long term drift in the
factory set calibration.

The input offset calibration provides a two point offset; a low point offset and a high point offset. The two

point offset constructs a straight line (linear calibration) between the two points. To insure greatest accuracy,
it is best to calibrate with the two points at the minimum and maximum operating ranges of the system.

HO® A a4

LOOP 1 Input Offset

Process Yalue: 20.9 Apply low scale input signal and
adjust low point offset until the

. . process value is equal to the
Low Point Offset: required value.

Press to Display/Adjust High Point Offset

Allow for at least a 30 minute warm-up period BEFORE performing the
calibration offset.

To begin calibration, send the low signal input to the loop input. If the process value does not match the
reference signal, adjust the low point offset so that the process value matches the reference input signal.
Press the button to switch to the high point offset and then apply the high signal input to the loop control.
Adjust the high point offset if necessary in order to make the process value match the reference signal.
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9.6 Display Settings

The Display screen provides access to the touch screen calibration utility, back light settings and alarm

volume.
_

Display

Calibrate Touch Back Light

Alarm Yolume
Alarm Test

The Alarm Volume adjusts how loud the internal alarm buzzer of EZT-430i will be when activated under an
alarm condition. The volume can be set from 0 (off) to 100. To edit the alarm volume, touch the entry field
and enter the desired volume level. To test the buzzer, press the “Alarm Test” button.

9.6.1 Calibrate Touch

After extended use and many hours of operation, it may be necessary to recalibrate the touch screen of EZT-
430i. A typical sign that the screen may be out of adjustment, is inaccurate responses when attempting to
press buttons, check boxes or adjust fields on the display. The calibration utility is provided in order to
readjust the screen when this happens.

To begin the calibration process, press the “Calibrate Touch” button. An alert message will appear stating
that the application will be disabled to perform the calibration procedure. Press “Yes” to continue.

The application will be disabled. Yes

. |
(|

The calibration utility will start and crosshairs will appear on the screen. At each crosshair position, touch the
screen at the center of the crosshairs. Repeat this for each position in order to set the calibration. The
calibration requires five points, the center and four corners.
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NOTE: It is recommended that you use your finger rather than a stylus when calibrating the screen. The
touch response will be more fluid after calibrating it with your finger.

Carefully press and briefly hold stylus on the center of the target,
Repeat as the target moves around the screen,

_|_

Once complete, the calibration utility will provide a notification message that the new calibration settings have
been measured and to touch the screen to register the new calibration data; just touch anywhere on the
screen to close the window and return to the EZT-430i application to resume normal operation.

Mewy calibration settings have been measured.
Touch the screen to register saved data,

9.6.2 Backlight Settings

The backlight settings allow the user to adjust the screen brightness as well as set a time period for dimming
the backlight after a period of inactivity which can extend the life of the display. To adjust the backlight
settings press the “Back Light” button. An alert message will appear stating that the application will be
disabled to enter the backlight settings; press “Yes” to continue.

Select the “Backlight” tab from on the Display Properties window. Press the “Advanced...” button to access
the settings for the backlight.

NOTE: The checkboxes on the Backlight tab for “Automatically turn off backlight while on battery power”

and “Automatically turn off backlight while on external power” have no effect on backlight operation
and should be left unchecked.
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To save battery life, you can adjust when the backlight
automatically shuts off,

[ utornatically turn off backlight while on battery power:
Turn off after |15 s=ror

Corc: + | of continuous idle time,

[ Automatically turn off backlight while on external power z :
Turn off after |1 e [ of continuous idie time,| Advanced...

The brightness of the display during operation is set by adjusting the “ON” slider. The default setting is 100.
The “OFF” slider is used to adjust the brightness of the display during periods of inactivity. The default setting
is 10. Note that a setting of zero (0) does not completely turn off the backlight.

Backir Brighthess ——— ([ Timer
= oM 100 OFF 16 [v! Autornatically tum off
6 backlight.
== [ ]
[ [1 mirute |
L (4 ] Cancel ] ...

To enable the backlight dimming function, place a check in the “Automatically turn off backlight.” checkbox
and set the delay time using the drop down selection box. The delay time can be set at fixed intervals from as
little as 15 seconds to as long as 30 minutes.

Once all settings are complete, press the “OK” button and then press the “OK” button at the top right of the
“Display Properties” window to return to the EZT-430i application and begin normal operation.
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9.7 Configuration

The Configuration utility allows the user to back up the entire configuration of EZT-430i and save it to a file for
“safe keeping” in case of system damage due to a lightning strike, etc. The utility also allows EZT-430i to be
configured with a push of a button by selecting from a list of preconfigured setups that could be created and
saved on a USB memory device, for loading a configuration to a new EZT-430i system.

IMPORTANT: Do not import configuration files that are not intended for use with the current
hardware configuration of EZT-430i as unexpected operation may result.

Configuration
e

Reset default configuration

Import File Loaded:

When the Export button is pressed, the EZT-430i configuration data will be written to the USB memory
device. The export file function will use the name entered in the text field to the right of the export button and
create a directory on the memory stick with that name, to contain the configuration data. The filename can be
entered with up to 10 characters which permits multiple configurations to be identified and saved for later
retrieval. The export file will be saved with a name format of “cfg_filename_mm_dd_yy hh _mm_ss” to
identify the configuration according to the date and time it was created. This prevents multiple configuration
files with the same name from overwriting previous files. It also allows the user to identify a backup of EZT-
430i so that it could be reconfigured to a previous date if multiple back-ups are created.

The Import button is used to write the configuration data to EZT-430i from the currently loaded file. To load a
configuration file, the USB memory device must first be inserted into the USB port. When the Load
Configuration button is pressed, a list of available configuration files from the memory stick will be shown.
Select the desired file from the list and press “Open” to load the file. Once the file is loaded, the import
process can begin. Pressing the “Import” button will begin the process. When the import is complete, you
must cycle power to EZT-430i in order for the new configuration data to be loaded into runtime memory for
proper operation.

The Reset default configuration button can be used to clear the current EZT-430i configuration and reset
the system back to default values. This function clears all user configuration values and returns the system to
an “as new” factory state allowing the system to be configured from scratch. This function is provided as a
means to start over in the event that the system configuration has been altered to an unknown state and is
not operating properly, and a known good configuration is not available to import. Rather than go through
every setting of every feature to try and determine where the configuration error exists, this allows the system
to be cleared so that it can be reconfigured from a clean slate.

NOTE: The configuration functions do not affect the VNC server configuration. The enable state, VNC

address, device name and password fields must be manually changed as these settings are specific
to each device and must be set independently for proper VNC server operation over a network.
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9.8 About EZT-430i

The “About” EZT-430i screen provides operating system version numbers for the currently installed firmware
and program of both the EZT-430i HMI and loop controls. This information should be recorded prior to any
service request so that proper assistance can be provided for your control model.

9.9 Exit Application

The “Exit” Application screen allows the user to quit the EZT-430i runtime software and return to the CE.Net
operating system. This operation is NOT recommended with the exception of users who are in charge of
system configuration due to the danger of editing or removing files by accident.

Exit Application

Exit application. {(automatic mode startup).

Exit application. {configuration mode startup)

The automatic mode startup option will return EZT-430i to normal operation on the next power up.

The configuration mode startup option will start the EZT-430i configurator program on the next power up so
that the user can access control loop and EZT-430i runtime settings.
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10 Communications

This section provides instructions on how to use the EZT-430i communication interfaces. As a standard,
EZT-430i is equipped with both an Ethernet interface and an RS232 serial interface for user communications.

10.1 Ethernet Communications

EZT-430i provides two forms of Ethernet communication interfaces for monitoring and controlling the system
across a network. The web server interface provides a monitor only connection, while the VNC server
interface allows a user to manipulate and control the EZT-430i remotely by viewing the EZT-430i display
directly on their PC screen.

NOTE: In order to use Ethernet communications, EZT-430i must be properly connected to a network. To
connect EZT-430i to a network, connect the touch screen’s Ethernet port to your network using a
standard CAT5 cable connection. Note that after connecting the network cable, it may be necessary
to cycle power to EZT-430i in order for it to obtain a valid IP address.

10.1.1 Guide to Smart Networking Practices

The expansion of Ethernet onto the industrial floor has brought forth a new realm of possibilities from the
gathering of information to the inherent control of equipment from anywhere around the world. The flexibility
and convenience that this provides makes it a very desirable feature for new equipment. EZT-430i provides
this ability, but there are considerations that must be taken by the end user to protect their equipment and
investment.

Just like placing a personal computer on the internet opens it up to outside attack, placing your EZT-430i on a
network poses the same risk. The first thing to remember is this: The most likely cause of problems is not a
hacker trying to sabotage your equipment, but more often to be related to the ubiquity of PCs with Ethernet
cards, the ease with which your own co-workers can ‘hang stuff on the network,” and careless or nonexistent
internal security measures. Accidental problems are more common than deliberate ones.

Allowing anyone access to EZT-430i by placing it on the office LAN, also opens the door for accidental
shutdown, damage to equipment, loss of data, lost time, etc. This is possible even by the most well-
intentioned co-workers. Thus, there are several steps that should be taken to minimize this risk.

The first is to never mix your office LAN with your control LAN. The control LAN should be a separate
network that consists of your EZT-430i controller(s) and possibly any other equipment that you may have that
is related to the operation of the system. It should be separated from your office LAN by a firewall, or at
minimum, a bridge or router. A control network and a business network have two entirely different purposes
and their interaction should be closely controlled.

It is also unwise to assume that any Ethernet capable devices themselves have any security features at all.
The EZT-430i VNC server only provides minimal single-password based security access. Separating the
control LAN from the office LAN using a firewall would increase security and only allow control access that is
based on a combination of IP source address, destination address, and port number. This is by no means
completely ‘hacker-proof,” but it should keep the well-meaning co-workers out.

Another hazard is connecting consumer ‘plug and play’ devices to your control LAN. A printer for example,
might flood the network with traffic in a ‘broadcast storm’ as it tries to self-configure or advertise its presence
to all nodes on the network. Faulty devices, for example defective NIC cards, can transmit large amounts of
bad packets (i.e., runts, which are abnormally short Ethernet frames) into your network. Using switches
instead of hubs will limit the effect of such problems.
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The most commonly overlooked source of problems is cabling. Not all cables are created equal. Electrical
noise generated by factory equipment or other electrical equipment in the area, could easily corrupt
transmitted data over the network and cause devices to ‘lock up’ or shut down the VNC server, both of which
then require EZT-430i to be shut down and restarted to clear the problem.

Select the right cable for the environment. Shielded twisted pair (STP) cable is naturally more noise immune
and is preferable to unshielded twisted pair or UTP in noisy situations. STP should have at least 40dB CMRR
and less than 0.1pF capacitance unbalance per foot. Ground STP cable, making sure the ground is
connected only at one end. CAT5 STP patch panels normally provide a grounding strip or bar. Hubs and
switches don’t provide grounding, use cables.

It's wise to be pessimistic about a cable’s ability to reject noise from 230 VAC and 460 VAC power lines and
electrically ‘noisy’ equipment in the area. Capacitance imbalance in cables greater than 70pF per 100m can
introduce harmonic distortion, resulting in bit errors. The cost of cable is quite small compared to total
equipment cost, so if you're looking to save money, this is not a place to do it. Choose a well-designed cable
to minimize bit-error rate after installation, and that will give faster throughput with fewer glitches.

10.1.2 Configuring the EZT-430i Network

In order to connect to the VNC server or web server of EZT-430i, you will need to know the IP address of
EZT-430i on the network. It is important to note that if using DHCP in your network router, the EZT-430i
address may change on re-power requiring you to access the EZT-430i controller directly in order to obtain
the new IP address. This could result in VNC/web server connection issues if the address regularly changes.

Therefore, it is recommended that the IP address for EZT-430i be assigned as a fixed (static) address. This
insures that the address will not change once it has been set. This can be done in one of two ways. The first
is by setting up the control LAN router to assign the same IP address whenever it detects the EZT-430i device
on the network via its own identifier; it's MAC address.

The other option is to configure EZT-430i to use a fixed IP address and disable the DHCP addressing function
of its network interface. When using this method, it is important to make sure that the address being assigned
to EZT-430i is not used by any other device on the network. If another device is using the same address, the
VNC and web server interfaces will not function correctly. It is recommended that this method of static IP
assignment be used as it removes the IP address lease renewal process that would be performed by the
control LAN router if DHCP was used.

The lease renewal process performed by the control LAN router can cause the VNC server in EZT-430i to
shut down due to an issue in the renewal process. It could be caused by something in the router firmware or
configuration of the router itself. Due to the numerous brands and models of routers available, and the
dynamic nature of their use, attempting to resolve the issue is beyond the scope of this manual. Therefore,
the use of static IP addressing removes this from the equation, providing the most robust network solution.

10.1.2.1 Obtaining the EZT-430i" MAC Address

The MAC address can be obtained from the network connections screen. In order to access the screen, you
must exit the EZT-430i application. To do so, proceed to the ‘Exit Application’ screen under the offline setup
menu. Press the ‘Exit and start runtime on next power up’ button to exit the EZT-430i runtime application.
Follow the on screen prompts to stop the application and exit to the Windows CE desktop.

NOTE: The text, “System Startup Please Wait...” on the desktop is static and does not indicate that any
application is going to start at this time. It is used as a “placeholder” prior to the EZT-430i runtime or
configuration application starting during normal power-up sequences so that the user is informed that
an action is taking place.
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System Startup

Please Wait....

From the desktop, touch the narrow, gray bar at the bottom of the screen to show the taskbar.

System Startup

Please Wait....

Network Icon

#start | e le] )

Next, ‘double-click’ on the network connections icon to open the network connection information window.
Two tabs will be provided; one for IP Information and the other for IPv6 Information. To obtain the MAC
address, press the ‘Details...” button on the IP information tab.

D4
Pl Metwiork Connection Details:
_1| | Property Walue |
Physical Address 0004 DS 01 45 EB
IP Address 192,168.0.12
Subnet Mask 255.255.255.0
Default Gateway 192.168.0.1
DHCP Server 192,168.0.1
Lease Ohtained 9/16/2009 10:15:55
Lease Expires oQf17f2009 10:19:55
DMS Servers 152.95.1.1
| WINS Servers

! P I
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The MAC address is displayed as the first item (Physical Address). Once the address has been recorded,
close the network information windows and cycle power to EZT-430i in order to restart the system and return
to normal operation.

10.1.2.2 Setting a Static IP Address

In order to set a static IP address for EZT-430i on a network, it requires you to exit the EZT-430i application
and enter the ‘Network and Dial-up Connections’ settings of the CE operating system.

IMPORTANT: It is recommended that only personnel charged with configuring and maintaining EZT-
430i perform this procedure. Do not alter, change or delete any other files or settings
of the system. Doing so may render EZT-430i inoperable.

To begin, you must exit the EZT-430i application. To do so, proceed to the ‘Exit Application’ screen under the
offline setup menu. Press the ‘Exit and start runtime on next power up’ button to exit the EZT-430i runtime
application. Follow the on screen prompts to stop the application and exit to the Windows CE desktop.

System Startup

Please Wait....

From the desktop, touch the narrow, gray bar at the bottom of the screen to show the taskbar. Before
proceeding any further, enable the CE keyboard so that it will be available to enter in the IP address. If you
do not enable it now, you will not be able to access the taskbar later once in the Ethernet Drivers screen.

System Startup

Please Wait....

¥ Keyboard

LargeKB

Keyboard Icon

T L 735 PM ([
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To enable the keyboard, touch the keyboard icon at the lower right of the taskbar and select ‘Keyboard’ from
the menu. This will make the keypad visible. Next, press the Windows Start button and select ‘Settings’ and
then ‘Network and Dial-up Connections’ to show the connections window.

Make MNew
Connection

System Startup

Please Wait....

) Programs *

f?Fa_vorites 4
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From the ‘Connection’ window, select the current network connection by ‘double-tapping’ the connection icon
to enter its property window. DO NOT create a new connection. The ‘Ethernet Drivers’ property window will
allow you to set the IP address as well as name primary and secondary DNS and WINS servers from the
‘Name Servers’ tab if necessary. Select ‘Specify an IP address’ and enter in the desired IP address, subnet
mask and default gateway.

You can move the keyboard around on the screen to position it as necessary to access the different fields.
Once complete, close the ‘Ethernet Drivers’ window by pressing the ‘OK’ button located at the top right of the
window. Next, close the Connection window by pressing the ‘X’ button at the top right of the window.

| | =1 /I'DMO000 Fast Ethernet Adapter’ Settings

L" IP Address |Narne Servers |

Mak
cganr?e An IP address can be (7 Obtain an 1P address via DHCP

autornatically assigned to this .

computer, If your netwark @ Specify an IP address
does not automnatically assign .

IP addresses, ask your netwiork IP Acidress: |192 168, 1 . | |
adrninistrator for an address, Subnet Mask: | . . . |

efault Gateway: | . . . |
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Access the taskbar and hide the keyboard by pressing the keyboard button at the bottom right of the taskbar
and select ‘Hide Input Panel’. DO NOT cycle power to EZT-430i at this time. Wait approximately 2 minutes
before removing power. This provides time to allow the Windows CE operating system to save the new
network settings to the registry so that it uses the settings on the next reboot. If power is cycled too soon, the
network settings will revert back to the previous settings on the next power up. Once the 2 minute time period
has elapsed since updating the network settings, cycle power to EZT-430i in order to restart the system and
return to normal operation with the new network settings.

NOTE: The text, “System Startup Please Wait...” on the desktop is static and does not indicate that any
application is going to start at this time. It is used as a “placeholder” prior to the EZT-430i runtime or
configuration application starting during normal power-up sequences so that the user is informed that
an action is taking place.
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10.1.3 Using the Web Server

The EZT-430i web server allows a user to remotely monitor operations anywhere via a PC’s standard web
browser. When enabled, the web server provides a detailed status page of the current operating conditions.
The web server can be enabled and disabled by pressing the ‘Web Server’ button on the communications
screen under the ‘Comms’ setup menu.

You must use the assigned IP address to access EZT-430i. The IP address is shown on the communications
screen and is also included in the notifications list. Write down the IP address so you will have it later to enter
into your web browser.

Modbus Address

VYNC Address

VYNC Password * *

IP Address 192.168.0.6

[ ; [

NOTE: Contact your network administrator prior to enabling the web server of EZT-430i. Company policy
may prohibit the use of web servers for security reasons. CSZ is not responsible for the use of, nor
makes any claims as to the security of the web server interface over your network. The use of the
web server is the responsibility of the end user.

To access and view the EZT-430i web page, enter the following link in your PC’s browser address window:
http://"1Paddress”/orion.html From the example address shown on the screen above, then entry would be:
http://192.168.0.6/orion.html. The following example is typical of the EZT-430i web page appearance. The
web page updates automatically every 30 seconds and provides information on each individual control loop,
ramp/soak program status, alarm status and system event status.
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,f‘ Untitled Document - Intemet Explorer, optimized for Bing and MSN
@:__: L |g http://192.168.0.6/orion html j @ 4| K ﬁ Google 2|~
fj Fawortes @ Untitled Document | | ﬁ ~ B - [;ég -~ Page ~ Safety~ Tools ~ I@lv
Cincinnati Sub-Zero
12011 Mosteller Rd. Cincinnati, OH 45241
CONTROL DATA
|  LOOP1 PV =263 | SP=26.0
| LOOP2 PV=273 | SP=499
AUTOMATED PROGRAM
| Program Name | DTTAT
| Program Status | Off
| Cycles Remaining | 1
| Total Steps | 6
| Current Step | 1
| Step Time Running | 0.10
| Remaining Step Time | 0.10
| LOOP 1 Target SP | 50.0
| LOOP 2 Target SP | 50.0
SYSTEM ALARMS
SYSTEM EVENTS
| EV1 | OFF
| EV2 | OFF
| EV3 | OFF
| EV4 | OFF
| EV5 | OFF
=
Done [T T e intemet [7a - [ w1008 -~ 4
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10.1.4 Using the VNC Server

The EZT-430i VNC server allows a user to remotely monitor and control EZT-430i by directly viewing and
manipulating the touch screen over the network. You must use the assigned IP address and VNC port
number to access EZT-430i. The IP address is shown on the communications screen and is also included in
the notifications list. Write down the IP address and port number so you will have it to enter into your VNC
viewer.

There are many VNC viewers available for both PC and tablet use. Due to the ever changing market and
availability of such applications, it is not possible to test them all for compatibility or provide assistance for
their use with EZT-430i. It is the responsibility of the end user to test the chosen VNC client for compatibility
with EZT-430i prior to putting the unit into service. If the VNC client viewer has compatibility issues with EZT-
430i, it can cause the VNC server to stop responding and/or shut down requiring power to be cycled to EZT-
430i in order to reboot the system and restart the server.

CSZ Controls has tested and recommends the use of RealVNC's viewer. It has been tested for compatibility
with EZT-430i and a free version can be obtained from http://www.realvnc.com/ for PC/MAC use. RealVNC
does offer a version for the iPad that can be obtained through the App Store for a small fee. The App Store
also offers a free VNC client called Remotix for the iPad. It has also been tested for compatibility with EZT-
430i.

NOTE: Contact your network administrator prior to enabling the VNC server of EZT-430i. Company policy
may prohibit the use of VNC servers and/or viewers for security reasons. CSZ is not responsible for
the use of, nor makes any claims as to the security of the VNC server interface over your network.
The use of the VNC server is the responsibility of the end user.

NOTE: For further information regarding VNC severs, please reference the VNC Networking Guide.

10.1.4.1 Recommended VNC Viewer Settings (PC/MAC)

This section applies to setup of the recommended RealVNC viewer for PC/MAC. These settings have been
tested and evaluated in order to provide the best performance and quickest response to user input when
using the VNC viewer with EZT-430i. After installing the VNC viewer software, it is recommended that the
following changes be made to the default viewer settings.

To begin, start the VNC viewer. Click on the ‘Options’ button in order to open the ‘VNC Viewer - Options’
window.

BWCviewr K
N

VNCE®E Viewer
Vé

WNC Server: I j

Encryption: ILet WMC Server choose j

Click on the ‘Advanced’ button at the bottom left of the window in order to show the advanced setup options.
On the ‘Display’ tab, make sure the scaling is set to ‘No scaling’ and the checkbox for ‘Adapt to network
speed (recommended)’ is checked.
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VNC Viewer - Options

BESECOMBREssIoN S Best quia(itsy

[ o | conel |

Next, select the ‘Inputs’ tab and deselect all entries except for ‘Enable mouse input’ and ‘Rate-limit mouse
move events’. The ‘Inputs:’ drop down selection box will automatically change to ‘Custom’ when the settings
are made.

VNC Viewer - Options
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Proceed to the ‘Expert’ tab. Scroll down the list of settings until you find the ‘PreferredEncoding’ and
‘Protocol3.3' options. Set the preferred encoding to Hextile and the Protocol 3.3 option to true. Verify that the
‘Use these settings for all new connections’ checkbox at the bottom of the window is checked and click the
OK button. This will set the selections to the default start settings for the VNC viewer.

VNC Viewer - Options B3

Display I Inputs | Cnnnectinnl Printing Expert I

MName | Value | :I
Menukey

Maonitor

MRLEntries 20
PointerCornerSnapThreshold 30

P entInterval
PreferredEncoding Hextile
Protocol3. 3 True

ProxyServer

ProxyType

ProxyUserMame

RelativePtr Falze
ScalePrintOutput True
Scaling Maone
SecurityMotificationTimeout 2500
SelectDesktop

SendkeyEvents False
sendPointerEvents True LI
CarvariC it Tawt Falea

[V Use these settings for all new connections

Basic. .. | QK I Cancel |

10.1.4.2 Recommended VNC Viewer Settings for Tablets

The VNC clients for tablets have been found to offer limited flexibility for use with EZT-430i. Most clients have
default settings requiring security to be enabled on the server in order to connect. If you have trouble
connecting with a VNC viewer through an iPad, iPhone or even an Android based phone, start by enabling
the security on the EZT-430i VNC server and be sure to enter those settings in the client viewer.

Color and encoding options can also affect the connectivity. If the client offers the option, leave color and
encoding options to ‘automatically detect’ or ‘server decides’. If the client is still unable to connect, try default
encoding of Hextile and set the color option to limited colors such as 256 bit color. CSZ Controls does not
write or create VNC clients (3rd party software), so final selection of client and testing is the end user
responsibility. The following settings are provided as an example for the Remotix client for the iPad. When
adding an EZT-430i server to the Remotix client, use the following settings. Note that the VNC server in EZT-
430i must have security enabled in order for this client to connect.

Connection Type: VNC

Host/IP: IP address of EZT-430i

Port: VNC address of EZT-430i (5900 = 0, 5901 =1, etc...)
Use SSH Tunnel: Off

VNC Authentication: VNC Password

VNC Password: VNC password of EZT-430i

VNC Server Type: AutoDetect
Operating System: Windows
Preferred Encodings: Hextile
Color Depth: 16 bits
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10.1.4.3 Accessing EZT-430i through a VNC Viewer

The following examples are based on the use of the RealVNC viewer for PC/MAC. Once the default settings
have been entered, just enter the IP address and port number for EZT-430i, and click the ‘Connect’ button to
access EZT-430i over the network.

Intranet Example: If the IP address assigned is 192.168.3.5 and the configured VNC Address is 1, from the
PC’s VNC Viewer address field, enter '192.168.3.5:1’ to access the device (address 1 relates to port 5901,
address 2 to port 5902, etc., which is the port opened by the VNC interface in order to allow communications
with EZT-430i over the network).

BWCViewer _F|
VNCE Viewer Vn
-

YNC Server: | IEEBIERCRTS j

Encryption: ILet YMC Server choose j

Internet Example: Internet connection typically requires a qualified network System Administrator. Typically a
permanent IP address and specific port address are assigned to EZT-430i; support on this action is beyond
the scope of this guide. Consult your network system administrator for assistance in setting up an Internet
connection.

If the IP address of the LAN is 69.216.64.69 and the configured VNC Address is 1 (port 5901 has been
opened and assigned to this specific EZT-430i controller), from the remote PC (outside of the site Servers
LAN), in the VNC Viewer address field enter ‘69.216.64.69::5901' to access the device (5901 relates to
address 1, 5902 to address 2, 5903 to address 3, etc., note the double colon).

Evcvewr — F
n

VHNCE®E Viewer
Vé

YNC Server: | AT N Ie Al j

Encryption: ILet WMC Server choose j

NOTE: The IP address shown on the communications screen of EZT-430i is the LAN address and would
not typically be used for an Internet connection.

Security Example: If the VNC server password is enabled on EZT-430i, for either example above, upon
pressing the ‘Connect’ button to make the connection, the VNC viewer will prompt for the proper password.
The connection will only be established once the valid password is entered.
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[ VNC Viewer - Authentication ]|

n VMC Server: 192.165.3.5:1
V Username: I

Password: I L

0K I Cancel

Once the connection is established, the current EZT-430i display will be shown on your desktop. The image
will be a duplicate of what is on the EZT-430i. As you manipulate the screen, the display of EZT-430i will also
be manipulated so that any local operator will be able to see what is happening and vice versa.

- 10] x|

Vi nCompas=
- @ ‘h 5:12 PM
v
b

N LOOP 1

100.0 %

| Manual Control | Automatic Tune

Multiple instances of the VNC viewer can be started on your PC. By running multiple viewers, you can have
access to multiple EZT-430i controllers right from your desktop. The heading of each VNC viewer window will
use the ‘'VNC Device Name’ entry for the header. By entering a unique name for each EZT-430i, you can
identify each VNC connection and know which system you are accessing. The VNC viewer is meant to be
used for short term control access to EZT-430i. It is not meant for long term monitoring of system operation.
If long term monitoring access is desired, use the built-in web server of EZT-430i or a PC with CSZ software
to monitor and control EZT-430i over its serial communications port. The web server interface and PC
software is designed for long term monitoring and status updates.

Due to the nature of VNC operation, and for security reasons, the VNC viewer connection should not be left
open on your desktop. The viewer connection should be opened in order to perform the necessary control
and/or status check of system operation, and then closed once the task is complete. Accidental manipulation
of the control or erroneous network activity could cause connection problems over the VNC interface and
result in the VNC server shutting down and requiring EZT-430i to be restarted in order to regain access.

NOTE: Some viewers may also contain additional features for file transfer and other high level functions.
These functions are NOT compatible with EZT-430i. Any attempt to use them may cause the EZT-
430i to malfunction and require power to be cycled in order to reboot the system. All viewers should
be used ONLY to monitor and manipulate EZT-430i as if you were standing directly in front of it.
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Serial Communications Option

The EZT-430i serial interface uses Modbus RTU protocol. Any device used to communicate with EZT-430i
over the serial interface must use this protocol. The interface can be configured to operate in either standard
EZT-430i LC mode or a simulated Watlow F4S/D mode.

4/23/2013
5:04 PM

Modbus Address Parity Even -
VNG Address Pswrd MNone T

VYNC Password * *

IP Address 192.168.0.6

[ Whanw, [ VNG

When configured for the standard EZT-430i LC interface, the communication address and parity can be set
on the Web/Modbus/VNC. All other communication settings are fixed. The port settings of the device used to
communicate with EZT-430i must be set to match in order for the communications to take place.

Address: 1-31 (user selectable)
Baud Rate: 9600

Data Bits: 8
Stop Bits: 1
Parity: None, Odd, Even (user selectable)

When configured for the simulated Watlow F4S/D interface, only the communications address can be set.
The parity setting is hidden and defaulted to “None” in order to be compatible with WatView software or other
devices used to communicate with a Watlow FA4S/D controller. The port settings of the device used to
communicate with EZT-430i must be set to match the standard F4 settings as follows:

Address: 1-31 (user selectable)
Baud Rate: 19200

Data Bits: 8
Stop Bits: 1
Parity: None

IMPORTANT: See the EZT-430i User Communications Reference Manual for details on using the simulated
Watlow F4S/D interface as functionality is limited to features compatible with the CSZ EZT-
430i controller.

The Modbus address is used to identify EZT-430i on the serial link. When a multi-drop connection is used,
each controller on the link must have a different address so that each one can be identified separately. If two
or more EZT-430i controllers have duplicate addresses, communications with those controllers will fail
because they will each try to respond to the same message. For single EZT-430i connections, the address
only needs to match that of the commands being sent from the host device.
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11 Alarm Codes and Troubleshooting

This section provides explanations of standard EZT-430i alarms to help in diagnosing and resolving the alarm
conditions. Note that the information provided here covers standard alarms only, and not alarms configured
by the OEM for system. If you are unable to diagnose a problem through the use of this guide, contact your

OEM for further assistance.

A\

Some of the troubleshooting procedures may require access to live circuitry. Dangerous
accidental contact with line voltage may be possible.
should be allowed to perform these procedures..

Only qualified service personnel

Alarm Monitor Description

Explanation/Corrective Action

“tagname” A to D converter failure

(error code 40) Indicates that the analog to digital converter in the loop
controller indicated by “tagname” has failed. Return to factory for repair or
replace.

Auto tune failed for “tagname”.

(error code 26) Indicates that auto tune was unable to execute properly for
the loop controller indicated by “tagname”. Verify that PB >0 and TI1>0 before
starting auto tune. Try manual tuning instead of auto tuning if the process
has a very slow response.

“tagname” cold junction failure

(error code 30) Indicates that the cold junction compensation in the loop
controller indicated by “tagname” has failed. Return to factory for repair or
replace.

Communications error with “tagname”.
Check cable.

Check communication wiring between COM2 of the EZT-430i touch screen
and the loop controller indicated by “tagname”. Verify that the loop control
has the proper communications address and communications settings.

“tagname” EEPROM failure

(error code 29) Indicates that the memory in the loop controller indicated by
“tagname” has failed. Return to factory for repair or replace.

Email Error! Check cable or server

down.

Indicates that EZT-430i was unable to send an alarm message through the
mail server. Verify that EZT-430i is properly connected to the network and
that the email settings and addresses are valid.

FTP! Check cable or server down.

Indicates that the FTP back-up attempt of the data files failed. Verify that
EZT-430i is properly connected to the network and that the FTP settings are
valid.

If EZT-430i is not connected to a network, disable the FTP data back-up to
prevent seeing this alarm.

NTP Ping Failed. Check Cable.

Indicates that EZT-430i was unable to synchronize its clock with the selected
national time server. Verify that EZT-430i is properly connected to the
network and the selected time server is accessible.

If EZT-430i is not connected to a network, disable the NTS clock to prevent
seeing this alarm.
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Alarm Monitor Description

Explanation/Corrective Action

“tagname” outputs 1 and 2 incorrectly
configured.

(error code 4) Indicates that the control loop configuration for the loop
controller indicated by “tagname” is not valid and must be corrected to clear
the alarm. Check and correct setup values of output 2, PB, Tl and output 1.
If output 2 is required for cooling control, the control should use PID mode
(PB > 0, Tl > 0 ) and output 1 should use reverse mode (heat action),
otherwise, don't use output 2 for cooling control.

Program run error. “Loop 1” and “Loop
2" are not synchronized.

Alarm applies to dual loop EZT-430i systems only and indicates that the
running program (in each loop control) is operating with a difference of more
than 1 minute between the steps programmed for each loop.

NOTE: This alarm does not affect program operation. In order to clear the
alarm, the program will have to be stopped. If the alarm will not clear, but the
program indicates it is off, select “Stop” from the Program menu and then try
to clear the alarm again.

The timing accuracy of the EZT-430i loop controls is +30 seconds per month.
This may cause one loop control to execute the program slightly faster than
the other. For programs with long term operation, weeks or months, one loop
may get significantly ahead of the other causing it to begin its next ramp or
soak step ahead of the other affecting product or test results.

Verify that the program end set point configuration for each loop is set to the
same function. Verify that the event input functions (if used) are configured
for the same function.

“tagname” sensor break

Check sensor wiring for the loop controller indicated by “tagname”. Verify
lead connections. If sensor requires power, verify power to sensor.
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Appendix

EZT-430iTouch Screen Interface Specifications (page 1 of 3)

Technical Specifications

Description Details

Size 4.3"

Resolution (W X H in pixels) 480 x 272
Display type TFT, Wide touch Screen
Colors 65,536

Touch screen Type Resistive analog
Active display area (W X H mm) 95 X 54

MTBF back light at 25 0C 30,000 hrs
Backlight LED
Brightness Adjustment Yes

Screen Saver Yes

Language Fonts Yes

Main Hardware

Description Details
Processor, CPU speed ARM11, 533Mhz
Flash Memory(ROM) 128 MB
SDRAM(RAM) 128 MB
Operating system WinCE 6.0
Real Time Clock Yes

Buzzer Yes

Sound Output N/A

SD card slot Yes
Communication Ports/Interfaces

Description Details
RS232C, DB9 Male 1

RS232C/ RS422/ RS485, DB25 Female 1

Ethernet 10/100 Mbps, RJ45 Option

USB Host 1

General Specifications

Description Details

Rated Voltage 24V DC

Power supply 11-36V DC
Rated Current 0.91A (DC)
Power Consumption (without sound output) 10w

Power on LED indicator Yes

Outer dimensions (W X H X D mm) 140 X 116 X 57
Mounting depth (mm) 51

Panel cut (W X H mm)

123" x 99™*

Protection

IP65 front, IP20 rear

Front bezel, housing

Plastic, plastic

Stainless Steel front bezel (Option) N.A
Installation Panel Mount
Net Weight (KQg) 0.5
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EZT-430i Touch Screen Interface Specifications (page 2 of 3)

Standards, Certificates and Approvals

Description Details

UL approval UL 508 and CSA C22.2 No.142
Low Voltage Directive 2006/95/EC

EMC Directive 2004/108/EC

Requirements for Emission EN 61000-6-4 :2007
Requirements for Interference Immunity EN 61000-6-2 :2005

Tick mark for Australia AS/NZS CISPR 11:2004

FCC FCC Part 15, Subpart B, Class A

Base Standards for EMC & Safety

Description Details
Electrostatic discharge IEC 61000-4-2: 2008
Radiated radio-frequency electromagnetic fields IEC 61000-4-3: 2006 + A1:2007 + A2:2010
Electrical fast transient/burst IEC 61000-4-4: 2004 + Al: 2010
Surge IEC 61000-4-5: 2005
Conducted disturbances induced by radio- IEC 61000-4-6: 2008
frequency fields
Power frequency magnetic field IEC 61000-4-8: 2009
Voltage dips, short interruptions and voltage IEC 61000-4-11: 2004
variations
Emission from Electromagnetic fields CISPR 11:2009 + A1:2010 Class A
Harmonics Current IEC61000-3-2:2005 + A1:2008 + A2:2009
Voltage Fluctuation and Flicks IEC61000-3-3:2008
Requirements for Safety EN61010-1:2001
Protective class
Description Details
Standard enclosures IP 65 (Front), IP20 housing and terminals
Stainless steel front — Option IP 66K (Front), IP20 housing and terminals

Transport & Storage conditions

Description Details

Temperature -20C to + 60C

Relative Humidity 10% to 90%, no condensation
Altitude 2000 meters maximum

Sinusoidal vibration conforming to IEC 60068-2-6 510 10 Hz: 3.5 mm amplitude
10 to 150 Hz: 2g loct/min. 40 sweeps
Shock conforming to IEC 60068-2-29 3 shocks per direction 11ms 15g

Best conditions for storage of LCD display modules:
Room ambient temperature 15°C to 35°C and 65% RH or less.
Do not store in surroundings containing organic solvent or corrosive gas.
Store HMI in anti-electrostatic container or bag.
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EZT-430i Touch Screen Interface Specifications (page 3 of 3)

Operating conditions

Description Details

Temperature 0C to + 50C

Relative Humidity 10% to 90%, no condensation
Altitude 2000 meters maximum
Pollution Degree 2

Sinusoidal vibration conforming to

IEC 60068-2-6

10 to 58Hz: 0.75mm amplitude
58 to 150Hz: 1g l1oct/min. 1 sweep

Shock conforming to IEC 60068-2-29

3 shocks per direction 11ms 10g

NOTE: In temperatures below 0°C, the response time of liquid crystal display becomes slower and color of
the display will be darker than normal. Do not operate HMI in ambient temperature less than 0 C.

LCD specifications

Description Details
Touch operations 1,000,000 times using R 0.8 Polyacetal stylus with
force 250g

Vibration test

10-55 Hz, Stroke: 1.5mm, 2 hrs. for each direction of
X, Y, Z

Shock test

100 G, 6 ms, +/- X, +/-Y, +/- Z,
3 times for each direction

Package vibration test

0.015G*G/Hz from 5-200 Hz,
-6bB /Octave from 200-500 Hz,
2 hrs for each direction of X, Y, Z

Package drop test

10 drops from 60 cm on 1 corner, 3 edges, 6
surfaces

Typical Viewing Angle

Description Details
Vertical (Up/Down) 50°/70°
Horizontal (Left/Right) 70°/70°
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